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What’s new

April 29, 2024

Cumulative Update 9 (CU9) is the latest release of the Session Recording 1912 LTSR.
CU9 contains 1 fixed issue.

Cumulative Update 9 (CU9)

April 30, 2024

Release date: April 30, 2024

About this release

Session Recording 1912 LTSR Cumulative Update 8 (CU8)

Session Recording 1912 LTSR Cumulative Update 7 (CU7)

Session Recording 1912 LTSR Cumulative Update 6 (CU6)

Session Recording 1912 LTSR Cumulative Update 5 (CU5)

Session Recording 1912 LTSR Cumulative Update 4 (CU4)

Session Recording 1912 LTSR Cumulative Update 3 (CU3)

Session Recording 1912 LTSR Cumulative Update 2 (CU2)

Session Recording 1912 LTSR Cumulative Update 1 (CU1)

Session Recording 1912 LTSR (initial release)

Known issues

Deprecation and removals

Citrix Product Subscription Advantage Eligibility Dates

Fixed issues in 1912 LTSR CU9

April 29, 2024
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Compared to: Session Recording 1912 LTSR CU8

Session Recording 1912 LTSR CU9 contains all fixes included in the 1912 LTSR initial release, CU1, CU2,
CU3, CU4, CU5, CU6, CU7, CU8, plus the following, new fix:

• When using the OneIdentity Session Recording feature, the playback may appear pixelated on
certain VDAs. [CVADHELP‑24142]

Cumulative Update 8 (CU8)

September 11, 2023

Release date: September 11, 2023

About this release

CU8 contains no fixed issues.

Session Recording 1912 LTSR Cumulative Update 7 (CU7)

Session Recording 1912 LTSR Cumulative Update 6 (CU6)

Session Recording 1912 LTSR Cumulative Update 5 (CU5)

Session Recording 1912 LTSR Cumulative Update 4 (CU4)

Session Recording 1912 LTSR Cumulative Update 3 (CU3)

Session Recording 1912 LTSR Cumulative Update 2 (CU2)

Session Recording 1912 LTSR Cumulative Update 1 (CU1)

Session Recording 1912 LTSR (initial release)

Known issues

Deprecation and removals

Citrix Product Subscription Advantage Eligibility Dates

Cumulative Update 7 (CU7)

March 15, 2023

Release date: March 15, 2023
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About this release

CU7 contains no fixed issues.

Session Recording 1912 LTSR Cumulative Update 6 (CU6)

Session Recording 1912 LTSR Cumulative Update 5 (CU5)

Session Recording 1912 LTSR Cumulative Update 4 (CU4)

Session Recording 1912 LTSR Cumulative Update 3 (CU3)

Session Recording 1912 LTSR Cumulative Update 2 (CU2)

Session Recording 1912 LTSR Cumulative Update 1 (CU1)

Session Recording 1912 LTSR (initial release)

Known issues

Deprecation and removals

Citrix Product Subscription Advantage Eligibility Dates

Cumulative Update 6 (CU6)

October 31, 2022

Release date: October 31, 2022

About this release

CU6 contains no fixed issues.

Session Recording 1912 LTSR Cumulative Update 5 (CU5)

Session Recording 1912 LTSR Cumulative Update 4 (CU4)

Session Recording 1912 LTSR Cumulative Update 3 (CU3)

Session Recording 1912 LTSR Cumulative Update 2 (CU2)

Session Recording 1912 LTSR Cumulative Update 1 (CU1)

Session Recording 1912 LTSR (initial release)

Known issues

Deprecation and removals

Citrix Product Subscription Advantage Eligibility Dates
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Cumulative Update 5 (CU5)

May 17, 2022

Release date: March 09, 2022

About this release

CU5 contains no fixed issues.

Session Recording 1912 LTSR Cumulative Update 4 (CU4)

Session Recording 1912 LTSR Cumulative Update 3 (CU3)

Session Recording 1912 LTSR Cumulative Update 2 (CU2)

Session Recording 1912 LTSR Cumulative Update 1 (CU1)

Session Recording 1912 LTSR (initial release)

Known issues

Deprecation and removals

Citrix Product Subscription Advantage Eligibility Dates

Cumulative Update 4 (CU4)

May 17, 2022

Release date: November 03, 2021

About this release

CU4 adds three fixes compared with CU3.

Session Recording 1912 LTSR Cumulative Update 3 (CU3)

Session Recording 1912 LTSR Cumulative Update 2 (CU2)

Session Recording 1912 LTSR Cumulative Update 1 (CU1)

Session Recording 1912 LTSR (initial release)

Known issues
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Deprecation and removals

Citrix Product Subscription Advantage Eligibility Dates

Fixed issues in 1912 LTSR CU4

November 3, 2021

Compared to: Session Recording 1912 LTSR CU3

Session Recording 1912 LTSR CU4 contains all fixes included in the 1912 LTSR initial release, CU1, CU2,
CU3, plus the following, new fixes:

• Session Recording might fail to work. [CVADHELP‑17559]

• Session Recording Player might fail to playback some session recordings on the VDA causing
the SsRecPlayer.exe process to exit unexpectedly. [CVADHELP‑17678]

• This fix makes the agent side independent of the MSMQ‑HTTP‑support during msi installation.
[CVADHELP‑18307]

Cumulative Update 3 (CU3)

May 17, 2022

Release date: May 12, 2021

About this release

CU3 adds one fix compared with CU2.

Session Recording 1912 LTSR Cumulative Update 2 (CU2)

Session Recording 1912 LTSR Cumulative Update 1 (CU1)

Session Recording 1912 LTSR (initial release)

Known issues

Deprecation and removals

Citrix Product Subscription Advantage Eligibility Dates
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Fixed issues in 1912 LTSR CU3

May 12, 2021

Compared to: Session Recording 1912 LTSR CU2

Session Recording 1912 LTSR CU3 contains all fixes included in the 1912 LTSR initial release, CU1, CU2,
plus the following, new fix:

• When you enable event logging policies in the Session Recording Policy Console, some applica‑
tions might become unresponsive. [CVADHELP‑17292]

Cumulative Update 2 (CU2)

May 17, 2022

Release date: November 19, 2020

About this release

CU2 adds eight fixes compared with CU1.

Session Recording 1912 LTSR Cumulative Update 1 (CU1)

Session Recording 1912 LTSR (initial release)

Known issues

Deprecation and removals

Citrix Product Subscription Advantage Eligibility Dates

Fixed issues in 1912 LTSR CU2

November 19, 2020

Compared to: Session Recording 1912 LTSR CU1

Session Recording 1912 LTSR CU2 contains all fixes included in the 1912 LTSR initial release, CU1, plus
the following, new fixes:
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• Attempts to connect to the SessionRecording Server from theSessionRecordingPolicy Console
might fail. The following error message appears:

Unable to connect to the Session Recording Server. Ensure that the Session Recording
Server is running.

Unable to load site configuration.

The request was aborted. Could not create SSL/TLS secure channel.

[CVADHELP‑14525]

• Search for recordings might not work when the active recording viewing policy is configured
with theDomainGroup name. The issue occurswhen the viewer’s commonname and the login
name are different in Active Directory. [CVADHELP‑14809]

• Web browsing activitiesmight be captured evenwhen the Logwebbrowsing activities option
is not selected. The issue occurs when you select the Log top‑most window activities option
for an event logging policy. [CVADHELP‑15207]

• When a session is being recorded, the following warning message appears in an event viewer
log on the Session Recording Agent:

Receivedmessage forunknownsessionX. Thiswarningmayoccur if theSession recording
Agent has been restarted while ICA sessions were still active.

This issue does not impact the functioning of Session Recording.

[CVADHELP‑15208]

• Versions 1909 and 1912 of the web player do not work when you upgrade Session Recording to
version 2003 or earlier. [CVADHELP‑15324]

• When an event logging policy is active, the CPU utilization of the SsRecAgentWrapper process
might be high. As a result, recordings might be incomplete and Events 9 and 3017 appear in
Event Viewer. [CVADHELP‑15514]

• On Citrix Workspace app Version 1912 LTSR CU2, the Session Recording Playermight fail to play
files with an .icl extension. [CVADHELP‑15542]

• Unauthorized users can access the Session Recording web player to view recordings.
[CVADHELP‑16199]

Cumulative Update 1 (CU1)

May 17, 2022

Release date: May 7, 2020

© 1999–2024 Cloud Software Group, Inc. All rights reserved. 10
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About this release

CU1 adds two fixes compared with the initial release of the 1912 LTSR.

Session Recording (initial release)

Known issues

Deprecation and removals

Citrix Product Subscription Advantage Eligibility Dates

Fixed issues in 1912 LTSR CU1

May 4, 2020

Compared to: Session Recording 1912 LTSR initial release

Session Recording 1912 LTSR CU1 contains all fixes included in the 1912 LTSR initial release, plus the
following, new fixes:

Agent

• TheSsRecAgentWrapper process of the Session Recording Agent can consume a significant
amount of the memory usage. For example, its memory consumption can increase to 3 GB per
session. [CVADHELP‑14153]

Player

• Microsoft Internet Explorer might fail to detect whether a session is logged off. [CVADHELP‑
14185]

What’s new

May 1, 2020

What’s new in 1912 LTSR

This release includes the following new features and enhancements:

© 1999–2024 Cloud Software Group, Inc. All rights reserved. 11
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Session Recording web player

Previously available as an experimental feature, Session Recordingweb player is now fully supported.
The web player adds support for Internet Explorer and load balancing scenarios, and provides a new
event filter to search for custom events in recordings. For more information, see Session Recording
web player.

Enhanced event logging

Session Recording can now log top‑most window activities and tag the events in the recording. The
process name, title, and process number are logged. Session Recording also enhances app monitor‑
ing. When you add a process to the App monitoring list, applications driven by the added process
and its child processes are allmonitored. Formore information, see Log events and see Event logging
policies.

Fixed issues in 1912 LTSR

July 6, 2021

Compared to: Session Recording 1909

Session Recording 1912 LTSR contains the following fixes:

• A blurred screen might appear when the Session Recording Player plays back a dual‑monitor
session. [SRT‑3971]

• VDAs might experience a fatal exception and display a blue screen. The issue occurs when the
File monitoring list contains an extra semicolon (;) or only blank spaces between semicolons.
[SRT‑4075]

• A black screen might appear when the web player plays back a recording with ultra‑high reso‑
lution. [SRT‑4022]

Known issues

February 28, 2024

The following issues have been identified in this release:

© 1999–2024 Cloud Software Group, Inc. All rights reserved. 12
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• If you are using Citrix Web App Firewall (WAF) signatures tomitigate in part the CVE‑2021‑44228
vulnerability, Session Recording might not work as expected. To resolve the issue, exclude the
IP addresses of your Session Recording servers from themitigate_cve_2021_44228 policy on
the NetScaler side. [CVADHELP‑24365]

• A domain user with local administrator privileges on themachine where the Session Recording
Policy Console is installed can add both local users and domain users to which the action of a
policy rule applies. However, a local user with local administrator privileges can add only local
users but not domain users. [SRT‑5769]

• If youhave theTSkeycreatedunderHKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\SessionEvents,
certain events are not captured regardless of the key values. To capture various events properly,
use the Session Recording Policy Console to set event logging policies. [SRT‑4168]

• The same record appears twice on the “Record Reason Logging”page of Session Recording Ad‑
ministrator Logging. [SRT‑4003]

• When Machine Creation Services (MCS) or Provisioning Services (PVS) creates multiple VDAs
with the configuredmaster imageandMicrosoftMessageQueuing (MSMQ) installed, those VDAs
can have the same QMId under certain conditions. This case might cause various issues, for ex‑
ample:

– Sessions might not be recorded even if the recording agreement is accepted.
– The Session Recording Servermight not be able to receive session logoff signals and there‑
fore, sessions might always be in a live state.

For information about a workaround, see Install, upgrade, and uninstall. [#528678]

Third party notices

October 20, 2021

Session Recording 1912 LTSR (PDF Download)

This release of Session Recording can include third party software licensed under the terms defined
in this document.

System requirements

July 22, 2021

© 1999–2024 Cloud Software Group, Inc. All rights reserved. 13
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Session Recording includes the Session Recording Administration components, the Session Record‑
ing Agent, and the Session Recording Player. You can install the Session Recording Administration
components (Session Recording Database, Session Recording Server, and Session Recording Policy
Console) on a single server or on different servers. The following section details the requirements for
each of the Session Recording components.

For more information about using a Current Release (CR) in a Long Term Service Release (LTSR) envi‑
ronment and other FAQs, see Knowledge Center article.

Session Recording Database

Supported operating systems:

• Windows Server 2019
• Windows Server 2016
• Windows Server 2012 R2

Supported Microsoft SQL Server versions:

• Microsoft SQL Server 2019 Enterprise, Express, and Standard editions
• Microsoft SQL Server 2017 Enterprise, Express, and Standard editions
• Microsoft SQL Server 2016 SP2 Enterprise, Express, and Standard editions
• Microsoft SQL Server 2016 SP1 Enterprise, Express, and Standard editions
• Microsoft SQL Server 2014 SP2 Enterprise, Express, and Standard editions
• Microsoft SQL Server 2012 SP3 Enterprise, Express, and Standard editions
• Microsoft SQL Server 2008 R2 SP3 Enterprise, Express, and Standard editions

Requirement: .NET Framework 4.7.2

Session Recording Server

Supported operating systems:

• Windows Server 2019
• Windows Server 2016
• Windows Server 2012 R2

Other requirements:

• Internet Information Services (IIS) 10, 8.5, 8.0, or 7.5
• .NET Framework Version 4.7.2
• If the Session Recording Server uses HTTPS as its communications protocol, add a valid certifi‑
cate. Session Recording uses HTTPS by default, which Citrix recommends.

© 1999–2024 Cloud Software Group, Inc. All rights reserved. 14

https://support.citrix.com/article/CTX205549


Session Recording 1912 LTSR

• MicrosoftMessageQueuing (MSMQ),withActiveDirectory integrationdisabledandMSMQHTTP
support enabled.

• For Administrator Logging: Latest version of Chrome, Firefox, or Internet Explorer 11

Session Recording Policy Console

Supported operating systems:

• Windows Server 2019
• Windows Server 2016
• Windows Server 2012 R2

Requirement: .NET Framework 4.7.2

Session Recording Agent

Install the Session Recording Agent on everyWindows Virtual Delivery Agent (VDA) onwhich youwant
to record sessions.

Supported operating systems:

• Windows Server 2019
• Windows Server 2016
• Windows Server 2012 R2
• Windows 10, minimum version 1607
• Windows 10 Enterprise for Virtual Desktops

Requirements:

• Citrix Virtual Apps and Desktops 7 1912 with Premium license
• XenApp and XenDesktop 7.15 LTSR CU5 with Platinum license
• .NET Framework 4.7.2
• MicrosoftMessageQueuing (MSMQ),withActiveDirectory integrationdisabledandMSMQHTTP
support enabled

Session Recording Player

Supported operating systems:

• Windows Server 2019
• Windows Server 2016
• Windows Server 2012 R2
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• Windows 10, minimum version 1607

Requirement: .NET Framework 4.7.2

For optimal results, install the Session Recording Player on a workstation with:

• Screen resolution of 1024 x 768
• Color depth of at least 32‑bit
• 2GBRAMminimum;moreRAMandCPU/GPUresources can improveperformancewhenplaying
graphics‑intensive recordings, especially when recordings contain many animations

The seek response time depends on the size of the recording and yourmachine’s hardware specifica‑
tions.

Get started

June 18, 2020

Session Recording consists of five components:

• Session Recording Agent. A component installed on each VDA for multi‑session OS or single‑
session OS to enable recording. It is responsible for recording session data.

• Session Recording Server. A server that hosts:

– The Broker. An IIS 6.0+ hosted Web application that handles the search queries and file
download requests from the Session Recording Player, handles policy administration re‑
quests from the Session Recording Policy Console, and evaluates recording policies for
each Citrix Virtual Apps and Desktops session.

– The StorageManager. AWindows service thatmanages the recorded session files received
from each Session Recording‑enabled computer running Citrix Virtual Apps and Desktops.

– Administrator Logging. An optional subcomponent installed with the Session Recording
Server to log the administration activities. All the logging data is stored in a separate SQL
Server database named CitrixSessionRecordingLogging by default. You can customize
the database name.

• Session Recording Player. A user interface that users access from a workstation to play
recorded session files.

• Session Recording Database. A component that manages the SQL Server database for stor‑
ing recorded session data. When this component is installed, it creates a database named Cit‑
rixSessionRecording by default. You can customize the database name.

• Session Recording Policy Console. A console used to create policies to specify which sessions
are recorded.
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This illustration shows the Session Recording components and their relationship with each other:

In the deployment example illustrated here, the Session Recording Agent, Session Recording Server,
Session Recording Database, Session Recording Policy Console, and Session Recording Player all re‑
side behind a security firewall. The Session Recording Agent is installed on a VDA for multi‑session
OS or single‑session OS. A second server hosts the Session Recording Policy Console, a third server
acts as the Session Recording Server, and a fourth server hosts the Session Recording Database. The
Session Recording Player is installed on a workstation. A client device outside the firewall communi‑
cates with the VDA for multi‑session OS on which the Session Recording Agent is installed. Inside the
firewall, the Session Recording Agent, Session Recording Policy Console, Session Recording Player,
and Session Recording Database all communicate with the Session Recording Server.

Plan your deployment

June 21, 2024
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Limitations and caveats

Session Recording does not support Desktop Composition Redirection (DCR) display mode. By de‑
fault, Session Recording disables DCR in a session if the session is to be recorded by recording policy.
You can configure this behavior in Session Recording Agent properties.

If some URLs are configured in the browser content redirection policy that was introduced in Version
7.16 of the Windows VDA, graphics activities of browsing these URLs in the Internet Explorer browser
cannot be recorded.

Session Recording does not support the Framehawk display mode. Sessions in Framehawk display
mode cannot be recorded and played back correctly. Sessions recorded in Framehawk display mode
might not contain the sessions’activities.

Session Recording cannot record the Lyncwebcam videowhen using the HDX RealTimeOptimization
Pack.

Depending upon your environment, you can deploy the Session Recording components in different
scenarios.

A Session Recording deployment is not limited to a single site. Except the Session Recording Agent,
all components are independent of the server site. For example, you can configure multiple sites to
use a single Session Recording Server.

Alternatively, if you have a large site with many agents and plan to record many graphically intense
applications (for example, AutoCAD applications), or you have many sessions to record, a Session
Recording Server can experience a high performance demand. To alleviate performance issues, you
can install multiple Session Recording Servers and enable the load balancing feature to make the
Session Recording Servers work as a load balancing pool and to share the work load from different
VDAs.

Suggested server site deployment

Use this typeof deployment for recording sessions for oneormoreSites. TheSessionRecordingAgent
is installed on each VDA in a Site. The Site resides in a data center behind a security firewall. The Ses‑
sion Recording Administration components (Session Recording Database, Session Recording Server,
andSessionRecordingPolicyConsole) are installedonother servers and theSessionRecordingPlayer
is installed on a workstation, all behind the firewall but not in the data center.
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Important deployment notes

• To enable Session Recording components to communicate with each other, install them in the
same domain or across trusted domains that have a transitive trust relationship. The system
cannot be installed on a workgroup or across domains that have an external trust relationship.

• Considering its intensegraphical natureandmemoryusagewhenplayingback large recordings,
Citrix does not recommend installing the Session Recording Player as a published application.

• The Session Recording installation is configured for TLS/HTTPS communication. Ensure that
you install a certificate on the Session Recording Server and that the root certificate authority
(CA) is trusted on the Session Recording components.

• If you install the Session Recording Database on a standalone server running the Express Edi‑
tion of SQL Server 2019, SQL Server 2017, SQL Server 2016, SQL Server 2014, SQL Server 2012,
or SQL Server 2008 R2, the server must have the TCP/IP protocol enabled and the SQL Server
Browser service running. These settings are disabled by default, but they must be enabled for
the Session Recording Server to communicate with the database. For information about en‑
abling these settings, see the Microsoft articles Enable TCP/IP Network Protocol for SQL Server
and SQL Server Browser Service.

• Consider the effects of session sharingwhenplanning your SessionRecordingdeployment. Ses‑
sion sharing for published applications can conflict with Session Recording policy rules for pub‑
lished applications. Session Recording matches the active policy with the first published appli‑
cation that a user opens. After the user opens the first application, any subsequent applications
openedduring the same session continue to follow the policy that is in force for the first applica‑
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tion. For example, if a policy states to record only Microsoft Outlook, the recording commences
when the user opens Outlook. If the user opens a published Microsoft Word second while Out‑
look is running,Word also is recorded. Conversely, if the active policy does not specify to record
Word, and the user launches Word before Outlook, Outlook is not recorded.

• Though you can install the Session Recording Server on a Delivery Controller, Citrix does not
recommend that you do so because of performance issues.

• You can install the Session Recording Policy Console on a Delivery Controller.
• You can install both the Session Recording Server and the Session Recording Policy Console on
the same system.

• Ensure that the NetBIOS name of the Session Recording Server does not exceed the limit of 15
characters. Microsoft has a 15‑character limit on the host name length.

• PowerShell 5.1 or later is required for custom event logging. Upgrade PowerShell if you install
the Session Recording Agent onWindows Server 2012 R2 that has PowerShell 4.0 installed. Fail‑
ure to comply can cause failed API calls.

Security recommendations

June 21, 2024

Session Recording is deployed within a secure network and accessed by administrators, and as such,
is secure. Out‑of‑the‑box deployment is simple and security features such as digital signing and en‑
cryption can be configured optionally.

Communication between Session Recording components is achieved through Internet Information
Services (IIS) and Microsoft Message Queuing (MSMQ). IIS provides the web services communication
linkbetweenSessionRecordingcomponents. MSMQprovidesa reliabledata transportmechanism for
sending recorded session data from the Session Recording Agent to the Session Recording Server.

Warning:

Editing the registry incorrectly can cause serious problems that might require you to reinstall
your operating system. Citrix cannot guarantee that problems resulting from the incorrect use
of Registry Editor can be solved. Use Registry Editor at your own risk. Be sure to back up the
registry before you edit it.

Consider these security recommendations when planning your deployment:

• Configure Microsoft Internet Information Services (IIS).

YoucanconfigureSessionRecordingwitha restricted IIS configuration. OneachSessionRecord‑
ing Server, open the IIS Manager and set the following recycling limits for each IIS application
pool:
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– Virtual Memory Limit: Set the value to 4,294,967,295.
– PrivateMemoryLimit: Set the value tomatch thephysicalmemoryof theSessionRecord‑
ing Server. For example, if the physical memory is 4 GB, set the value to 4,194,304.

– RequestLimit: We recommendyou leave this settingunspecified. Or youcanset thevalue
to 4,000,000,000.

Tip:

To access the preceding settings, highlight each application pool, select Advanced Set‑
tings in the Actions pane, and then scroll down to theRecycling section in the Advanced
Settings dialog box.

• Ensure that you properly isolate the different administrator roles in the corporate network, in
the Session Recording system, or on individual machines. By not doing so, security threats that
can impact the system functionality or abuse the systemmight occur. We recommend that you
assign different administrator roles to different persons or accounts. Do not allow general ses‑
sion users to have administrator privileges to the VDA system.

– Citrix Virtual Apps and Desktops administrators do not grant VDA local administrator role
to any users of published apps or desktops. If the local administrator role is a requirement,
protect the Session Recording Agent components by usingWindowsmechanisms or third‑
party solutions.

– Separately assign the Session Recording database administrator and Session Recording
policy administrator.

– We recommend that you do not assign VDA administrator privileges to general session
users, especially when using Remote PC Access.

– Session Recording Server local administration account must be strictly protected.
– Control access tomachineswhere the Session Recording Player is installed. If a user is not
authorized for the Player role, do not grant that user local administrator role for any player
machine. Disable anonymous access.

– We recommend using a physical machine as a storage server for Session Recording.

• Session Recording records session graphics activities without regard to the sensitivity of the
data. Under certain circumstances, sensitive data (including but not limited to user credentials,
privacy information, and third‑party screens) might be recorded unintentionally. Take the fol‑
lowing measures to prevent risks:

– Disable core memory dump for VDAs unless for specific troubleshooting cases.

To disable core memory dump:

1. Right‑clickMy Computer, and then select Properties.
2. Click the Advanced tab, and then under Startup and Recovery, click Settings.
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3. UnderWrite Debugging Information, select (none).
See the Microsoft article at https://support.microsoft.com/en‑us/kb/307973.

– Session owners notify attendees that online meetings and remote assistance software
might be recorded if a desktop session is being recorded.

– Ensure that logon credentials or security information does not appear in all local andWeb
applications published or used inside the corporation. Otherwise, they are recorded by
Session Recording.

– Close any application that might expose sensitive information before switching to a re‑
mote ICA session.

– We recommend only automatic authentication methods (for example, single sign‑on,
smartcard) for accessing published desktops or Software as a Service (SaaS) applications.

• Session Recording relies on certain hardware and hardware infrastructure (for example, corpo‑
rate network devices, operation system) to function properly and to meet security needs. Take
measures at the infrastructure levels to prevent damage or abuse to those infrastructures and
make the Session Recording function secure and reliable.

– Properly protect and keep network infrastructure supporting Session Recording available.
– We recommend using a third‑party security solution or Windows mechanism to protect
Session Recording components. Session Recording components include:

* On the Session Recording Server
· Processes: SsRecStoragemanager.exe and SsRecAnalyticsService.exe
· Services: CitrixSsRecStorageManager and CitrixSsRecAnalyticsService
· All files in Session Recording Server installation folder
· Registry valueswithinHKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server

* On the Session Recording Agent
· Process: SsRecAgent.exe
· Service: CitrixSmAudAgent
· All files in Session Recording Agent installation folder
· Registry valueswithinHKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Agent

• Set the access control list (ACL) for Message Queuing (MSMQ) on the Session Recording Server
to restrict VDA or VDI machines that can send MSMQ data to the Session Recording Server and
prevent unauthorized machines from sending data to the Session Recording Server.

1. Install server feature Directory Service Integration on each Session Recording Server and
VDA or VDI machine where Session Recording is enabled. Then restart the Message Queu‑
ing service.

2. From the Windows Start menu on each Session Recording Server, open Administrative
Tools > Computer Management.
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3. Open Services and Applications >Message Queuing > Private Queues.

4. Click the private queue citrixsmauddata to open the Properties page and select the Se‑
curity tab.

5. Add the computers or security groups of the VDAs that send MSMQ data to this server and
grant them the SendMessage permission.
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• Properly protect the event log for the Session Record Server and Session Recording Agents. We
recommend using aWindows or third‑party remote logging solution to protect the event log or
redirect the event log to the remote server.

• Ensure that servers running the Session Recording components are physically secure. If possi‑
ble, lock these computers in a secure room to which only authorized personnel can gain direct
access.

• Isolate servers running the Session Recording components on a separate subnet or domain.

• Protect the recorded session data from users accessing other servers by installing a firewall be‑
tween the Session Recording Server and other servers.

• Keep the Session Recording Administration Server and SQL database up‑to‑date with the latest
security updates fromMicrosoft.

• Restrict non‑administrators from logging on to the administration machine.

• Strictly limit who is authorized to make recording policy changes and view recorded sessions.

• Install digital certificates, use the Session Recording file signing feature, and set up TLS commu‑
nications in IIS.

• SetupMSMQtouseHTTPSas its transport. Theway is to set theMSMQprotocol listed inSession
Recording Agent Properties to HTTPS. For more information, see Troubleshoot MSMQ.
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• Use TLS 1.1 or TLS 1.2 (recommended) and disable SSLv2, SSLv3, TLS 1.0 on the Session Record‑
ing Server and the Session Recording Database.

• Disable RC4 cipher suites for TLS on the Session Recording Server and the Session Recording
Database:

1. Using theMicrosoft Group Policy Editor, navigate to Computer Configuration > Adminis‑
trative Templates >Network > SSL Configuration Settings.

2. Set the SSL Cipher Suite Order policy to Enabled. By default, this policy is set to Not
Configured.

3. Remove any RC4 cipher suites.

• Use playback protection. Playback protection is a Session Recording feature that encrypts
recorded files before they are downloaded to the Session Recording Player. By default, this
option is enabled and is in Session Recording Server Properties.

• Follow NSIT guidance for cryptographic key lengths and cryptographic algorithms.

• Configure TLS 1.2 support for Session Recording.

We recommend using TLS 1.2 as the communication protocol to ensure the end‑to‑end security
of the Session Recording components.

To configure TLS 1.2 support of Session Recording:

1. Log on to themachine hosting the Session Recording Server. Install the proper SQL Server
client componentanddriver, andset strongcryptography for.NET Framework (version
4 or later).

a) Install the Microsoft ODBC Driver 11 (or a later version) for SQL Server.
b) Apply the latest hotfix rollup of .NET Framework.
c) Install ADO.NET - SqlClient based on your version of .NET Framework. For

more information, see https://support.microsoft.com/en‑us/kb/3135244.
d) AddaDWORDvalueSchUseStrongCrypto=1underHKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\.NetFramework\v4.0.30319

andHKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Microsoft\.NetFramework\v4.0.30319.
e) Restart the machine.

2. Log on to themachine hosting the Session Recording Policy Console. Apply the latest hot‑
fix rollup of .NET Framework, and set strong cryptography for .NET Framework (version 4
or later). The method for setting strong cryptography is the same as substeps 1–4 and 1–
5. You can omit these steps if you choose to install the Session Recording Policy Console
on the same computer as the Session Recording Server.

To configure the TLS 1.2 support for SQLServerwith versions earlier than 2016, see https://supp
ort.microsoft.com/en‑us/kb/3135244. To use TLS 1.2, configure HTTPS as the communication
protocol for the Session Recording components.
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Scalability considerations

June 21, 2024

Installing and running Session Recording requires few extra resources beyond what is necessary to
run Citrix Virtual Apps and Desktops. However, if you plan to use Session Recording to record many
sessions or if the sessions you plan to record can result in large session files (for example, graphically
intense applications), consider the performance of your system when planning your Session Record‑
ing deployment.

For more information about building a highly scalable Session Recording system, see Citrix article
CTX200869.

Hardware recommendations

Consider how much data you will be sending to each Session Recording Server and how quickly the
servers can process and store this data. The rate at which your system can store incoming data must
be higher than the data input rate.

To estimate your data input rate,multiply the number of sessions recordedby the average size of each
recorded session anddivide by the time forwhich you are recording sessions. For example, youmight
record 5,000 Microsoft Outlook sessions of 20 MB each over an 8‑hour work day. In this case, the data
input rate is approximately 3.5Mbps. (5,000 sessions times 20MBdivided by 8 hours, divided by 3,600
seconds per hour.)

You can improve performance by optimizing the performance of a single Session Recording Server or
by installing multiple Session Recording Servers on different machines.

Disk and storage hardware

Disk and storage hardware are the most important factors to consider when planning a Session
Recording deployment. The write performance of your storage solution is especially important. The
faster data can be written to disk, the higher the performance of the system overall.

Storage solutions suitable for use with Session Recording include a set of local disks controlled as
RAID arrays by a local disk controller or by an attached SAN.

Note:

Storing data on a NAS, based on file‑based protocols such as SMB and NFS, might have perfor‑
mance and security implications. Use the latest version of the protocol in place to avoid security
implications and perform scale testing to ensure proper performance.
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For a local drive setup, a disk controllerwith built‑in cachememory enhances performance. A caching
disk controller must have a battery backup facility to ensure data integrity in a power failure.

Network capacity

A 100 Mbps network link is suitable for connecting a Session Recording Server. A Gb Ethernet connec‑
tionmight improve performance, but does not result in 10 times greater performance than a 100Mbps
link.

Ensure that network switches used by Session Recording are not sharedwith third‑party applications
thatmight compete for available network bandwidth. Ideally, network switches are dedicated for use
with the Session Recording Server.

Computer processing capacity

Consider the following specifications for the computer on which a Session Recording Server is in‑
stalled:

• A dual CPU or dual‑core CPU is recommended
• 4 GB of RAM is recommended

Exceeding these specifications does not significantly improve performance.

Deploymultiple Session Recording Servers

If a single Session Recording Server does not meet your performance needs, you can install more
Session Recording Servers on different machines to have the Session Recording Servers work as a
load balancing pool. In this type of deployment, the Session Recording Servers share the storage and
the database. To distribute the load, point the Session Recording Agents to the load balancer that is
responsible for the workload distribution.

Database scalability

The Session Recording Database requires Microsoft SQL Server 2019, Microsoft SQL Server 2017, Mi‑
crosoft SQL Server 2016, Microsoft SQL Server 2014, Microsoft SQL Server 2012, or Microsoft SQL
Server 2008 R2. The volume of data sent to the database is small because the database stores only
metadata about the recorded sessions. The files of the recorded sessions themselves are written to
a separate disk. Typically, each recorded session requires only about 1 KB of space in the database,
unless the Session Recording Event API is used to insert searchable events to the session.
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The Express Editions of Microsoft SQL Server 2019, Microsoft SQL Server 2017, Microsoft SQL Server
2016,MicrosoftSQLServer 2014,MicrosoftSQLServer 2012, andMicrosoftSQLServer 2008R2 impose
a database size limitation of 10 GB. At 1 KB per recording session, the database can catalog about
4,000,000 sessions. Other editions of Microsoft SQL Server have no database size restrictions and are
limited only by available disk space. As the number of sessions in the database increases, perfor‑
mance of the database and speed of searches diminishes only negligibly.

If you are notmaking customizations through the Session Recording Event API, each recorded session
generates four database transactions: two when recording starts, one when the user logs on to the
session being recorded, and one when recording ends. If you use the Session Recording Event API
to customize sessions, each searchable event recorded generates one transaction. Because even the
most basic database deployment can handle hundreds of transactions per second, the processing
load on the database is unlikely to be stressed. The impact is light enough that the Session Recording
Database can run on the same SQL Server as other databases, including the Citrix Virtual Apps and
Desktops data store database.

If your Session Recording deployment requiresmanymillions of recorded sessions to be cataloged in
the database, follow Microsoft guidelines for SQL Server scalability.

Install, upgrade, and uninstall

June 21, 2024

This article contains the following sections:

Installation checklist

Install Session Recording by using the Citrix Virtual Apps and Desktops installer

Automate installation

Upgrade Session Recording

Uninstall Session Recording

Installation checklist

You can install the Session Recording components by using the Citrix Virtual Apps and Desktops in‑
staller.

Before you start the installation, complete this list:
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� Step

Select the machines on which you want to install
the Session Recording components. Ensure that
eachmachine meets the hardware and software
requirements.
Use your Citrix account credentials to access the
Citrix Virtual Apps and Desktops download page
and download the product ISO file. Unzip the
ISO file or burn a DVD of it.
To use the TLS protocol for communication
between the Session Recording components,
install the correct certificates in your
environment.
Install any hotfixes required for the Session
Recording components. The hotfixes are
available from the Citrix Support.
Configure the Citrix Director to create and
activate the Session Recording policies. For
more information, see Configure Director to use
the Session Recording Server.

Note:

• We recommend that you divide the published applications into separate Delivery Groups
based on your recording policies. Session sharing for published applications can conflict
with the active policy if the applications are in the sameDelivery Group. Session Recording
matches the active policy with the first published application that a user opens. Starting
with the 7.18 release, you can use the dynamic session recording feature to start or stop
recording sessions at any time during the sessions. This feature can help to mitigate the
conflict issue with the active policy. For more information, see Dynamic session recording.

• If youareplanning touseMachineCreationServices (MCS)orProvisioningServices, prepare
a uniqueQMId. Failure to comply can cause recording data losses.

• SQL Server requires that TCP/IP is enabled, the SQL Server Browser service is running, and
Windows Authentication is used.

• To use HTTPS, configure server certificates for TLS/HTTPS.
• Ensure that users under Local Users and Groups > Groups > Users have
write permission to the C:\windows\Temp folder.
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Install Session Recording by using the Citrix Virtual Apps and Desktops installer

We recommend that you install the Session Recording Administration, Session Recording Agent, and
Session Recording Player components on separate servers. The following procedures detail how to
install these components:

Install the Session Recording Administration components

Install the Session Recording Agent

Install the Session Recording Player

Install the Session Recording Administration components

The Session Recording Administration components include the Session Recording Database, Session
Recording Server, and Session Recording Policy Console. You can choose the component to install on
a server.

Step 1: Download the product software and launch the wizard

1. If youhave not downloaded theCitrix Virtual Apps andDesktops ISO yet, use your Citrix account
credentials to access the Citrix Virtual Apps andDesktops download page. Download and unzip
the product ISO file or burn a DVD of it.

2. Use a local administrator account to log on to the machine where you are installing the Ses‑
sion Recording Administration components. Insert the DVD in the drive or mount the ISO file.
If the installer does not launch automatically, double‑click the AutoSelect application or the
mounted drive.
The installation wizard launches.
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Step2: Choosewhichproduct to install

Click Start next to the product to install Citrix Virtual Apps or Citrix Virtual Desktops.
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Step3: SelectSessionRecording

Select the Session Recording entry.
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Step4: Readandaccept the licenseagreement

On the Software License Agreement page, read the license agreement, accept it, and then click
Next.

Step 5: Select the components to install and the installation location On theCore Components
page:

• Location: By default, components are installed in C:\Program Files\Citrix. The default location
works for most deployments. You can specify a custom installation location.

• Component: By default, all the check boxes next to the components that can be installed are
selected. The installer knowswhether it is running on a single‑session OS or amulti‑session OS.
It allows the Session Recording Administration components to be installed on a multi‑session
OS only. It does not allow the Session Recording Agent to be installed on amachine that has no
VDA installed in advance. If you install the Session Recording Agent on a machine that has no
VDA installed in advance, the Session Recording Agent option is unavailable.

Select Session Recording Administration and clickNext.
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Step6: Select the features to install

On the Features page:

• By default, all the check boxes next to the features that can be installed are selected. Installing
all these features ona single server is fine for aproof of concept. However, for a largeproduction
environment, we recommend that you install the Session Recording Policy Console on a sepa‑
rate server and the Session Recording Server, Session Recording Administrator Logging, and
Session Recording Database on another separate server. The Session Recording Administrator
Logging is anoptional subfeature of the SessionRecording Server. Select the SessionRecording
Server before you can select the Session Recording Administrator Logging.

• To add another feature on the same server after you select and install a feature or features on it,
you can only run the msi package. You cannot run the installer again to achieve the goal.

Select the feature or features that you want to install and clickNext.

Step 6.1: Install the Session Recording Database

Note:

The Session Recording database isn’t an actual database. It is a component that creates and
configures the required databases in the Microsoft SQL Server instance during installation. Ses‑
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sion Recording supports three solutions for database high availability based on the Microsoft
SQL Server. For more information, see Database high availability.

There are typically three types of deployments for the Session Recording Database andMicrosoft SQL
Server:

• Deployment 1: Install the Session Recording Server and Session Recording Database on the
samemachine and the Microsoft SQL Server on a remote machine. (Recommended)

• Deployment 2: Install the Session Recording Server, Session RecordingDatabase, andMicrosoft
SQL Server on the samemachine.

• Deployment 3: Install the Session Recording Server on a machine and install both the Session
Recording Database and Microsoft SQL Server on another machine. (Not recommended)

1. On the Features page, select Session Recording Database and click Next.

2. On the Database and Server Configuration page, specify the instance name and database name
of the Session Recording Database and the computer account of the Session Recording Server. Click
Next.
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On the Database and Server Configuration page:

• Instancename: If thedatabase instance isnotanamed instanceasyouconfiguredwhenyouset
up the instance, you can use only the computer name of the SQL Server. If you have named the
instance, use computer‑name\instance‑nameas thedatabase instancename. Todetermine the
server instance name you are using, run select@@servername on the SQL Server. The return
value is the exact database instance name. If your SQL server is configured to be listening on
a custom port (other than the default port 1433), set the custom listener port by appending a
comma to the instance name. For example, typeDXSBC‑SRD‑1,2433 in the Instance name text
box, where 2433, following the comma, denotes the custom listener port.

• Database name: Type a custom database name in the Database name text box or use the de‑
fault database name preset in the text box. Click Test connection to test the connectivity to the
SQL Server instance and the validity of the database name.

Important:

A custom database namemust contain only A‑Z, a‑z, and 0–9, and cannot exceed 123 char‑
acters.

• You must have the securityadmin and dbcreator server role permissions of the database. If
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you do not have the permissions, you can:

– Ask the database administrator to assign the permissions for the installation. After the
installation completes, the securityadmin and dbcreator server role permissions are no
longer necessary and can be safely removed.

– Or, use the SessionRecordingAdministrationx64.msi package (unzip the ISO file, and you
can find this msi package under…\x64\Session Recording). During the msi installation, a
dialog box prompts for the credentials of a database administrator with the securityad‑
min and dbcreator server role permissions. Type the correct credentials and then click
OK to continue the installation.

The installation creates the Session Recording Database and adds themachine account of
the Session Recording Server as db_owner.

• Session Recording Server computer account:

– Deployments 1 and 2: Type localhost in the Session Recording Server computer ac‑
count text box.

– Deployment 3: Type the name of the machine hosting the Session Recording Server in
the format of domain\computer‑name. The Session Recording Server computer account
is the user account for accessing the Session Recording Database.

Note:

Attempts to install the Session Recording Administration components can fail with error
code 1603 when a domain name is set in the Session Recording Server computer ac‑
count text box. As aworkaround, type localhostorNetBIOSdomain name\machinename
in the Session Recording Server computer account text box. To get the NetBIOS domain
name, go to the machine where you installed the Session Recording Server and run $env
:userdomain in PowerShell or echo %UserDomain% in Command Prompt.

3. Review the prerequisites and confirm the installation.
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The Summary page shows your installation choices. You can clickBack to return to the earlier wizard
pages andmake changes, or click Install to start the installation.

4. Complete the installation.
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The Finish Installation page shows green checkmarks for all the prerequisites and components that
have been installed and initialized successfully.

Click Finish to complete the installation of the Session Recording Database.

Step6.2: Install theSessionRecordingServer 1. On theFeaturespage, selectSessionRecording
Server and Session Recording Administrator Logging. ClickNext.
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Note:

• The Session Recording Administrator Logging is an optional subfeature of the Session
Recording Server. Select the Session Recording Server before you can select the Session
Recording Administrator Logging.

• We recommend that you install the Session Recording administrator logging together with
the Session Recording server at the same time. If you don’t want the administrator logging
feature to be enabled, you can disable it on a later page. However, if you choose not to
install this feature at the beginning but want to add it later, you can onlymanually add it by
using SessionRecordingAdministrationx64.msi.

2. On the Database and Server Configuration page, specify the configurations.
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On the Database and Server Configuration page:

• Instance name: Type the name of your SQL Server in the Instance name text box. If you are
using anamed instance, type computer‑name\instance‑name; otherwise, type computer‑name
only. If your SQL server is configured to be listening on a custom port (other than the default
port 1433), set the custom listener port by appending a comma to the instance name. For exam‑
ple, typeDXSBC‑SRD‑1,2433 in the Instance name text box, where 2433, following the comma,
denotes the custom listener port.

• Database name: Type a custom database name in the Database name text box or use the de‑
fault database name CitrixSessionRecording that is preset in the text box.

• You must have the securityadmin and dbcreator server role permissions of the database. If
you do not have the permissions, you can:

– Ask the database administrator to assign the permissions for the installation. After the
installation completes, the securityadmin and dbcreator server role permissions are no
longer necessary and can be safely removed.

– Or, use the SessionRecordingAdministrationx64.msi package to install the Session Record‑
ing Server. During the msi installation, a dialog box prompts for the credentials of a data‑
base administrator with the securityadmin and dbcreator server role permissions. Type
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the correct credentials and then clickOK to continue the installation.

• After typing the correct instance name and database name, click Test connection to test the
connectivity to the Session Recording Database.

• Type the Session Recording Server computer account, and then clickNext.

3. On theAdministration Logging Configuration page, specify configurations for the Administration
Logging feature.

On the Administration Logging Configuration page:

• The Administration Logging database is installed on the SQL Server instance: This text box
is not editable. The SQL Server instance name of the Administration Logging database is auto‑
matically grabbed from the instance name that you typed on theDatabase and Server Config‑
uration page.

• Administrator Logging database name: If you choose to install the Session Recording Admin‑
istrator Logging feature, type a custom database name for the Administrator Logging database
in this text boxoruse thedefault databasenameCitrixSessionRecordingLogging that is preset
in the text box.
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Note:

The Administrator Logging database name must be different from the Session Recording
Database name that is set in the Database name text box on the previous Database and
Server Configuration page.

• After typing the Administrator Logging database name, click Test connection to test the con‑
nectivity to the Administrator Logging database.

• Enable Administration Logging: By default, the Administration Logging feature is enabled.
You can disable it by clearing the check box.

• Enablemandatory blocking: By default, mandatory blocking is enabled. The normal features
might be blocked if logging fails. You can disablemandatory blocking by clearing the check box.

ClickNext to continue the installation.

4. Review the prerequisites and confirm the installation.

The Summary page shows your installation choices. You can clickBack to return to the earlier wizard
pages andmake changes, or click Install to start the installation.

5. Complete the installation.
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The Finish Installation page shows green checkmarks for all the prerequisites and components that
have been installed and initialized successfully.

Click Finish to complete the installation of the Session Recording Server.

Note:

The Session Recording Server default installation uses HTTPS/TLS to secure communications. If
TLS is not configured in the default IIS site of the Session Recording Server, use HTTP. To do so,
cancel the selectionofSSL in the IISManagementConsolebynavigating to theSessionRecording
Broker site, opening the SSL settings, and clearing the Require SSL check box.

Step 6.3: Install the Session Recording Policy Console 1. On the Features page, select Session
Recording Policy Console and clickNext.
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2. Review the prerequisites and confirm the installation.
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The Summary page shows your installation choices. You can clickBack to return to the earlier wizard
pages andmake changes, or click Install to start the installation.

3. Complete the installation.
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The Finish Installation page shows green check marks for all the prerequisites and the component
that have been installed and initialized successfully.

Click Finish to complete your installation of the Session Recording Policy Console.

Step 7: Install Broker_PowerShellSnapIn_x64.msi

Important:

Touse theSessionRecordingPolicyConsole, install theBrokerPowerShell Snap‑in (Broker_PowerShellSnapIn_x64
.msi) manually. Locate the snap‑in on the Citrix Virtual Apps and Desktops ISO (\layout
\image-full\x64\Citrix Desktop Delivery Controller) and follow the
instructions for installing it manually. Failure to comply can cause an error.

Install the Session Recording Agent

Install the Session Recording Agent on the VDA or VDI machine on which you want to record ses‑
sions.
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Step1: Download theproduct softwareand launch thewizard Usea local administrator account
to log on to themachine where you are installing the Session Recording Agent component. Insert the
DVD in the drive or mount the ISO file. If the installer does not launch automatically, double‑click the
AutoSelect application or the mounted drive.

The installation wizard launches.

Step2: Choosewhichproduct to install

Click Start next to the product to install Citrix Virtual Apps or Citrix Virtual Desktops.
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Step3: SelectSessionRecording

Select the Session Recording entry.
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Step4: Readandaccept the licenseagreement

On the Software License Agreement page, read the license agreement, accept it, and then click
Next
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Step5: Select thecomponent to install andthe installation location

Select Session Recording Agent and clickNext.
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Step6: Specify theAgentconfiguration

On the Agent Configuration page: Type the computer name of the machine where you installed the
Session Recording Server and the protocol and port information for the connection to the Session
Recording Server. If you have not installed Session Recording yet, you can change such information
later in Session Recording Agent Properties.

Note:

There is a limitation with the test connection function of the installer. It does not support the
“HTTPS requires TLS 1.2”scenario. If you use the installer in this scenario, the test connection
fails but you can ignore the failure and click Next to continue the installation. It does not affect
normal functioning.
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Step7: Reviewtheprerequisitesandconfirmthe installation

The Summary page shows your installation choices. You can clickBack to return to the earlier wizard
pages andmake changes, or click Install to start the installation.
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Step8: Complete the installation

The Finish Installation page shows green checkmarks for all the prerequisites and components that
have been installed and initialized successfully.

Click Finish to complete the installation of the Session Recording Agent.

Note:

WhenMachine Creation Services (MCS) or Provisioning Services (PVS) createsmultiple VDAswith
the configured master image and Microsoft Message Queuing (MSMQ) installed, those VDAs can
have the sameQMIdunder certain conditions. This casemight cause various issues, for example:

• Sessions might not be recorded even if the recording agreement is accepted.
• The Session Recording Server might not be able to receive session logoff signals and there‑
fore, sessions might always be in Live status.

As aworkaround, create a uniqueQMId for each VDA and it differs depending on the deployment
methods.

No extra actions are required if single‑session OS VDAs with the Session Recording Agent in‑
stalled are created with PVS 7.7 or later and MCS 7.9 or later in the static desktop mode that
is, for example, configured to make all changes persistent with a separate Personal vDisk or the
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local disk of your VDA.

For multi‑session OS VDAs created with MCS or PVS and single‑session OS VDAs that are config‑
ured to discard all changes when a user logs off, use the GenRandomQMID.ps1 script to change
the QMId on system startup. Change the power management strategy to ensure that enough
VDAs are running before user logon attempts.

To use the GenRandomQMID.ps1 script, do the following:

1. Ensure that the execution policy is set to RemoteSigned or Unrestricted in PowerShell.

1 Set-ExecutionPolicy RemoteSigned

2. Create a scheduled task, set the trigger as on systemstartup, and runwith the SYSTEMaccount
on the PVS or MCSmaster imagemachine.

3. Add the command as a startup task.

1 powershell .exe -file C:\\GenRandomQMID.ps1

Summary of the GenRandomQMID.ps1 script:

1. Remove the currentQMId from the registry.
2. Add SysPrep = 1 to HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\MSMQ\

Parameters.
3. Stop related services, including CitrixSmAudAgent and MSMQ.
4. To generate a randomQMId, start the services that stopped previously.

Example GENRANDOMQMID.PS1:

1 # Remove old QMId from registry and set SysPrep flag for MSMQ
2
3 Remove-Itemproperty -Path HKLM:Software\Microsoft\MSMQ\Parameters\

MachineCache -Name QMId -Force
4
5 Set-ItemProperty -Path HKLM:Software\Microsoft\MSMQ\Parameters -Name "

SysPrep" -Type DWord -Value 1
6
7 # Get dependent services
8
9 $depServices = Get-Service -name MSMQ -dependentservices | Select -

Property Name
10
11 # Restart MSMQ to get a new QMId
12
13 Restart-Service -force MSMQ
14
15 # Start dependent services
16
17 if ($depServices -ne $null) {
18
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19
20     foreach ($depService in $depServices) {
21
22
23         $startMode = Get-WmiObject win32_service -filter "NAME = '$(

$depService.Name)'" | Select -Property StartMode
24
25         if ($startMode.StartMode -eq "Auto") {
26
27
28             Start-Service $depService.Name
29         }
30
31 }
32
33
34 }
35
36 <!--NeedCopy-->

Install the Session Recording Player

Install the Session Recording Player on the Session Recording Server or on workstations in the do‑
main.

Step1: Download theproduct softwareand launch thewizard Usea local administrator account
to log on to themachinewhere you are installing the Session Recording Player component. Insert the
DVD in the drive or mount the ISO file. If the installer does not launch automatically, double‑click the
AutoSelect application or the mounted drive.

The installation wizard launches.
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Step2: Choosewhichproduct to install

Click Start next to the product to install Citrix Virtual Apps or Citrix Virtual Desktops.
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Step3: SelectSessionRecording

Select the Session Recording entry.
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Step4: Readandaccept the licenseagreement

On the Software License Agreement page, read the license agreement, accept it, and then click
Next
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Step5: Select thecomponent to install andthe installation location

Select Session Recording Player and clickNext.
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Step6: Reviewtheprerequisitesandconfirmthe installation

The Summary page shows your installation choices. You can clickBack to return to the earlier wizard
pages andmake changes, or click Install to start the installation.
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Step7: Complete the installation

The Finish Installation page shows green checkmarks for all the prerequisites and components that
have been installed and initialized successfully.

Click Finish to complete the installation of the Session Recording Player.

Automate installation

Session Recording supports silent installation with options. Write a script that uses silent installation
and run the relevant commands.

Automate installation of the Session Recording Administration components

For example, the following command installs the Session Recording Administration components and
creates a log file to capture the installation information.

1 Msiexec /i "c:\SessionRecordingAdministrationx64.msi" ADDLOCAL="
SsRecServer,PolicyConsole,SsRecLogging,StorageDatabase"
DATABASEINSTANCE="WNBIO-SRD-1" DATABASENAME="CitrixSessionRecording"
LOGGINGDATABASENAME="CitrixSessionRecordingLogging" DATABASEUSER="
localhost" /q /l*vx "yourinstallationlog"

© 1999–2024 Cloud Software Group, Inc. All rights reserved. 63



Session Recording 1912 LTSR

2 <!--NeedCopy-->

Note:

You can find the SessionRecordingAdministrationx64.msi file on the Citrix Virtual
Apps and Desktops ISO under \layout\image-full\x64\Session Recording.

Where:

• ADDLOCAL provides the features for you to select. You can selectmore than one option. SsRec‑
Server is the Session Recording Server. PolicyConsole is the Session Recording Policy Console.
SsRecLogging is the Administrator Logging feature. StorageDatabase is the Session Recording
Database. Session Recording Administrator Logging is an optional subfeature of the Session
Recording Server. Select the Session Recording Server before you can select Session Recording
Administrator Logging.

• DATABASEINSTANCE is the instance name of the Session Recording database. For
example,.\SQLEXPRESS,computer‑name\SQLEXPRESS,computer‑name

• DATABASENAME is the database name of the Session Recording database.
• LOGGINGDATABASENAME is the name of the Administrator Logging database.
• DATABASEUSER is the computer account of the Session Recording Server.
• /q specifies quiet mode.
• /l*v specifies verbose logging.
• yourinstallationlog is the location of your installation log file.

Automate installation of the Session Recording Player andweb player

For example, the following commands install the Session Recording Player and web player, respec‑
tively.

1 msiexec /i "c:\SessionRecordingPlayer.msi" /q /l*\vx "
yourinstallationlog"

2 <!--NeedCopy-->

1 msiexec /i "c:\SessionRecordingWebPlayer.msi" /q /l*vx "
yourinstallationlog"

2 <!--NeedCopy-->

Note:

Youcan find theSessionRecordingPlayer.msi fileon theCitrix VirtualAppsandDesktops
ISOunder\layout\image-full\x86\Session RecordingandSessionRecordingWebPlayer
.msiunder \layout\image-full\x64\Session Recording.

Where:
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• /q specifies quiet mode.
• /l*v specifies verbose logging.
• yourinstallationlog is the location of your installation log file.

Automate installation of the Session Recording Agent

For example, the following command installs the Session Recording Agent and creates a log file to
capture the installation information.

For 64‑bit systems:

1 msiexec /i SessionRecordingAgentx64.msi /q /l*vx yourinstallationlog
SESSIONRECORDINGSERVERNAME=yourservername

2 SESSIONRECORDINGBROKERPROTOCOL=yourbrokerprotocol
SESSIONRECORDINGBROKERPORT=yourbrokerport

3 <!--NeedCopy-->

Note:

You can find theSessionRecordingAgentx64.msi file on the Citrix Virtual Apps and Desk‑
tops ISO under \layout\image-full\x64\Session Recording.

For 32‑bit systems:

1 msiexec /i SessionRecordingAgent.msi /q /l*vx yourinstallationlog
SESSIONRECORDINGSERVERNAME=yourservername

2 SESSIONRECORDINGBROKERPROTOCOL=yourbrokerprotocol
SESSIONRECORDINGBROKERPORT=yourbrokerport

3 <!--NeedCopy-->

Note:

You can find the SessionRecordingAgent.msi file on the Citrix Virtual Apps and Desktops
ISO under \layout\image-full\x86\Session Recording.

Where:

• yourservername is the NetBIOS name or FQDN of the machine hosting the Session Recording
Server. If not specified, this value defaults to localhost.

• yourbrokerprotocol is HTTP or HTTPS that the Session Recording Agent uses to communicate
with the Session Recording Broker. If not specified, this value defaults to HTTPS.

• yourbrokerport is the port number that the Session Recording Agent uses to communicate
with the Session Recording Broker. If not specified, this value defaults to zero, which directs the
Session Recording Agent to use the default port number for your selected protocol: 80 for HTTP
or 443 for HTTPS.

• /q specifies quiet mode.
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• /l*v specifies verbose logging.
• yourinstallationlog is the location of your installation log file.

Upgrade Session Recording

You can upgrade certain deployments to later versions without having to first set up newmachines or
Sites. You can upgrade from the version of Session Recording included in the latest CU of XenApp and
XenDesktop 7.6 LTSR, and from any later version, to the latest release of Session Recording.

Note:

When you upgrade Session Recording Administration from 7.6 to 7.13 or later and chooseMod‑
ify in SessionRecording Administration to add the Administrator Logging service, the SQLServer
instance name does not appear on the Administrator Logging Configuration page. The follow‑
ing errormessage appearswhen you clickNext: Database connection test failed. Pleaseenter
correctDatabase instancename. As aworkaround, add the readpermission for localhost users
to the following SmartAuditor Server registry folder: HKEY_LOCAL_MACHINE\SOFTWARE\
Citrix\SmartAuditor\Server.

You cannot upgrade from a Technical Preview version.

Requirements, preparation, and limitations

• Use the Session Recording installer’s graphical or command line interface to upgrade the Ses‑
sion Recording components.

• Before any upgrade activity, back up the database named CitrixSessionRecording in the SQL
Server instance. In this way, you can restore it if any issues are discovered after the database
upgrade.

• In addition to being a domain user, you must be a local administrator on the machines where
you are upgrading the Session Recording components.

• If the Session Recording Server and Session Recording Database are not installed on the same
server, youmust have thedatabase role permission toupgrade the SessionRecordingDatabase.
Otherwise, you can:

– Ask the database administrator to assign the securityadmin and dbcreator server role
permissions for the upgrade. After the upgrade completes, the securityadmin anddbcre‑
ator server role permissions are no longer necessary and can be safely removed.

– Or, use the SessionRecordingAdministrationx64.msi package to upgrade. During the msi
upgrade, a dialog box prompts for the credentials of a database administratorwhohas the
securityadmin and dbcreator server role permissions. Type the correct credentials and
then clickOK to continue the upgrade.
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• You can choose not to upgrade all Session Recording Agents at the same time. Session Record‑
ing Agent 7.6.0 (or later) is compatible with the latest (current) release of Session Recording
Server. However, some new features and bug fixes might not take effect.

• Any sessions started during the upgrade of Session Recording Server are not recorded.
• The Graphics Adjustment option in Session Recording Agent Properties is enabled by default
after a fresh installation or upgrade to keep compatible with the Desktop Composition Redirec‑
tion mode. You can disable this option manually after a fresh installation or upgrade.

• The administrator logging feature is not installed after you upgrade Session Recording from a
previous release where the feature is unavailable. To add the feature, modify the installation
after the upgrade.

• If there are live recording sessions when the upgrade process starts, there is little chance that
the recording can be complete.

• Review the following upgrade sequence, so that you can plan andmitigate potential outages.

Upgrade sequence

To upgrade an existing installation, go to eachmachine where you installed a Session Recording com‑
ponent and then run the Citrix Virtual Apps and Desktops ISO.

Tip:

Go to the Citrix Virtual Apps and Desktops download page to download the appropriate version
of Citrix Virtual Apps and Desktops.

Upgrading an existing installation generally follows the following sequence:

1. Upgrade the Session Recording server component.

If there are more than one Session Recording server, first upgrade the one where the Session
Recording database component is installed. After that, upgrade the rest Session Recording
servers.

To do so, complete the following steps:

a) Stop the Session Recording Storage Manager service manually on the Session Recording
server.

b) Through the Internet Information Services (IIS) Manager, ensure that the Session Record‑
ing Broker is running.

c) Run the Citrix Virtual Apps and Desktops ISO and select the Session Recording entry to
upgrade.

2. The Session Recording service is back online automatically when the upgrade of the Session
Recording server is completed.
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3. Upgrade the Session Recording agent (on the master image).

4. Upgrade the Session Recording policy console with or after the Session Recording server.

5. Upgrade the Session Recording player.

Uninstall Session Recording

To remove the Session Recording components from a server or workstation, use the uninstall
or remove programs option available from the Windows Control Panel. To remove the Session
Recording Database, youmust have the same securityadmin and dbcreator SQL Server role permis‑
sions as when you installed it.

For security reasons, the Administrator Logging Database is not removed after the components are
uninstalled.

Dynamic session recording

June 21, 2024

Previously, session recording started strictly at the very beginning of sessions that met the recording
policies and stopped strictly when those sessions ended.

Starting with the 7.18 release, Citrix introduces the dynamic session recording feature. With this fea‑
ture, you can start or stop recording a specific session or sessions that a specific user launches, at any
time during the sessions.

Note:

Tomake the feature work as expected, upgrade Session Recording, VDA, and Delivery Controller
to Version 7.18 or later.

Enable or disable dynamic session recording

On the Session Recording Agent, a registry value is added for enabling or disabling the feature. The
registry value is set to 1 by default, which means that the feature is enabled by default.

To enable or disable the feature, do the following:

1. After the Session Recording installation is complete, log on as an administrator to the machine
where you installed the Session Recording Agent.

2. Open the Registry Editor.
3. Browse to HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor.
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4. Set the value of DynamicControlAllowed to 0 or use the default value, 1.
1: enable dynamic recording
0: disable dynamic recording

5. Restart the Session Recording Agent to make your setting take effect.
If you are using MCS or PVS for deployment, change the setting on your master image and per‑
form an update to make your change take effect.

Warning:

Incorrectly editing the registry can cause serious problems that might require you to reinstall
your operating system. Citrix cannot guarantee that problems resulting from the incorrect use
of Registry Editor can be solved. Use Registry Editor at your own risk. Be sure to back up the
registry before you edit it.

Dynamically start or stop recording by using PowerShell commands in the Citrix
Broker SDK

The following table lists three PowerShell commands added in the Citrix Broker SDK for the dynamic
session recording feature. For informationon theCitrix Broker SDK, seeCitrix SDKs andAPIs andCitrix
Virtual Apps and Desktops SDK.

Command Description

Start‑BrokerSessionRecording Lets you start recording a specific active session,
a list of active sessions, or sessions launched by
a specific user. For more information, run Get-
Help Start-BrokerSessionRecording
to see the command online help.

Stop‑BrokerSessionRecording Lets you stop recording a specific active session,
a list of active sessions, or sessions launched by
a specific user. For more information, run Get-
Help Stop-BrokerSessionRecording
to see the command online help.

Get‑BrokerSessionRecordingStatus Lets you get the recording status of a specific
active session. For more information, run
Get-Help Get-
BrokerSessionRecordingStatus to see
the command online help.

For example, when a user reports an issue and needs timely support, you can use the feature to dy‑
namically start recording the user’s active sessions, and play back the live recording to proceed with
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the follow‑up troubleshooting. You can do the following:

1. Launch PowerShell from the Citrix Studio console.

2. Use the Get-BrokerSession command to get all the active sessions of the target user.

3. Use the Get-BrokerSessionRecordingStatus command to get the recording status of
the specified session.

Note:

The ‑Session parameter can accept only one session Uid at a time.

4. Use the Start-BrokerSessionRecording command to start recording. By default, a no‑
tification message appears to inform users of the recording activity.

The following table shows commonways of using the Start-BrokerSessionRecording
command.
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Command Description

Start‑BrokerSessionRecording ‑User DomainA \
UserA

Starts recording all sessions of user UserA in the
domain named DomainA and notifies UserA.

Start‑BrokerSessionRecording ‑User DomainA \
UserA ‑NotifyUser $false

Starts recording all sessions of user UserA in the
domain named DomainA and does not notify
UserA.

Start‑BrokerSessionRecording ‑Sessions
$SessionObject

Starts recording all sessions in the object named
$SessionObject and notifies the user. To get the
object $SessionObject, run
$SessionObject=Get-BrokerSession
–username UserA. The name of an object is
prefixed with a dollar sign $. For more
information, see Step 2 and the command online
help.

Start‑BrokerSessionRecording ‑Sessions
uid1,uid2,…,uidn

Starts recording the sessions uid1, uid2,…, and
uidn, and notifies the users.

5. Use the Get-BrokerSessionRecordingStatus command to get the recording status of
each target session. The status is supposed to be SessionBeingRecorded.

6. Play back the Live or Complete recordings in the Session Recording Player and proceed with
the follow‑up troubleshooting.

Note�

The last section of the timeline on the Player progress bar might show gray when you
play back a “Complete”recording ended by the Stop-BrokerSessionRecording
command and the last section of the recorded session is idle. It is not obvious when the
recorded session has constant activities.

7. Use the Stop-BrokerSessionRecording command to stop recording when the reported
issue has been triaged or resolved.

The following table shows common ways of using this command:

Command Description

Stop‑BrokerSessionRecording ‑User DomainA \
UserA

Stops recording all sessions of user UserA in the
domain named DomainA.

Stop‑BrokerSessionRecording ‑Sessions
$SessionObject

Stops recording all sessions in the
$SessionObject.
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Command Description

Stop‑BrokerSessionRecording ‑Sessions
uid1,uid2,…,uidn

Stops recording the sessions uid1, uid2,…, and
uidn.

On theCitrixStudioLogging screen, youcanviewthe resulting logsof theStart-BrokerSessionRecording
and Stop-BrokerSessionRecording commands.

Configure

April 29, 2020

After installing the Session Recording components, you can perform the following steps to configure
SessionRecording to recordCitrix Virtual Apps andDesktops sessions and allowusers to view them:

• Configure the connection to the Session Recording Server
• Authorize users
• Create and activate recording policies
• Specify where recordings are stored
• Specify file size for recordings
• Customize notification messages
• Enable or disable recording
• Enable or disable digital signing
• Administrator Logging
• Database high availability
• Load balancing
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• Change your communication protocol
• Configure CEIP

Configure the connection to the Session Recording Server

June 5, 2024

Configure the connection of the Session Recording Player to the Session Recording
Server

Before a Session Recording Player can play sessions, configure it to connect to the Session Recording
Server that stores the recorded sessions. Each Player can be configured with the ability to connect to
multiple Session Recording Servers, but can connect to only one Session Recording Server at a time.
If the Player is configured with the ability to connect to multiple Session Recording Servers, users
can change which Session Recording Server the Player connects to by selecting a check box on the
Connections tab at Tools >Options.

1. Log on to the workstation where the Session Recording Player is installed.
2. Start the Session Recording Player.
3. From the Session Recording Player menu bar, choose Tools >Options.
4. On the Connections tab, click Add.
5. In theHostname field, type the name or IP address of themachine hosting the Session Record‑

ing Server and select the protocol. By default, Session Recording is configured to use HTTP‑
S/SSL to secure communications. If SSL is not configured, select HTTP.

6. Toconfigure theSessionRecordingPlayerwith theability to connect tomultipleSessionRecord‑
ing Servers, repeat Steps 4 and 5 for each Session Recording Server.

7. Ensure that you select the check box for the Session Recording Server you want to connect to.

Configure the connection of the Session Recording Agent to the Session Recording
Server

The connection between the Session Recording Agent and the Session Recording Server is typically
configured when the Session Recording Agent is installed. To configure this connection after the Ses‑
sion Recording Agent is installed, use Session Recording Agent Properties.

1. Log on to the server where the Session Recording Agent is installed.

2. From the Startmenu, choose Session Recording Agent Properties.
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3. Click the Connections tab.

4. In the Session Recording Server field, type the FQDN of the Session Recording Server.

Note:

To useMessageQueuing over HTTPS (TCP is used by default), type an FQDN in the Session
Recording Server field. Otherwise, session recording fails.

5. In the Session Recording Storage Manager message queue section, select the protocol that
is used by the Session Recording StorageManager to communicate and change the default port
number if necessary.

Note:

To use Message Queuing over HTTP and HTTPS, install all the IIS recommended features.

6. In theMessage life field, accept the default 7,200 seconds (two hours) or type a new value for
thenumberof secondseachmessage is retained in thequeue if there is a communication failure.
After this time elapses, the message is deleted and the file is playable until the point where the
data is lost.

7. In the Session Recording Broker section, select the communication protocol that the Session
Recording Broker uses to communicate and change the default port number if necessary.

8. When prompted, restart the Session Recording agent service to accept the changes.

Authorize users

June 19, 2020

To grant users the rights, you assign users to roles using the Session Recording Authorization Console
on the Session Recording Server. Five roles are available:

Important:

For security reasons, grant users only the rights they need to perform specific functions, such as
viewing recorded sessions.

• PolicyAdministrator. Grants the right to view, create, edit, delete, and enable recording poli‑
cies. By default, administrators of the machine hosting the Session Recording Server are mem‑
bers of this role.

• PolicyQuery. Allows the servers hosting the Session Recording Agent to request recording pol‑
icy evaluations. By default, authenticated users are members of this role.
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• LoggingWriter. Grants the right to write the Administrator Logging logs. By default, local ad‑
ministrators and the Network Service group are members of this role. Changing the default
LoggingWritermembership can cause log writing failure.

• LoggingReader. Grants the right to query the Administrator Logging logs. There is no default
membership in this role.

• Player. Grants the right to view recorded Citrix Virtual Apps and Desktops sessions. There is
no default membership in this role. When you install Session Recording, no user has the right
to play recorded sessions. You must assign the right to each user, including the administrator.
A user without the permission to play recorded sessions receives the following error message
when trying to play a recorded session:

To assign users to a role, do the following:

1. Log on as an administrator to the machine hosting the Session Recording Server.
2. Start the Session Recording Authorization Console.
3. Select the role to which you want to assign users.
4. From themenu bar, choose Action > Assign Users and Groups.
5. Add the users and groups.

Session Recording supports users and groups defined in Active Directory.

Any changes made to the console take effect during the update that occurs once every minute. Also,
starting with the 1906 release, you can use the Session Recording Policy Console to create recording
viewing policies. For more information, see Recording viewing policies.

Configure policies

March 21, 2024
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Use the Session Recording Policy Console to create recording policies, event logging policies, and
recording viewing policies. When creating the policies, you can specify Delivery Controllers fromboth
the Citrix Cloud and on‑premises environments.

Important:

To use the Session Recording Policy Console, youmust have the Broker PowerShell Snap‑in (Bro‑
ker_PowerShellSnapIn_x64.msi) or the Citrix Virtual Apps andDesktops Remote PowerShell SDK
(CitrixPoshSdk.exe) installed manually. The installer does not install the snap‑ins automatically.
Locate theBrokerPowerShell snap‑inon theCitrix Virtual AppsandDesktops ISO (\layout\image‑
full\x64\Citrix DesktopDelivery Controller), or download the Citrix Virtual Apps andDesktops Re‑
mote PowerShell SDK from the Citrix Virtual Apps and Desktops Service download page.

Tip:

You can edit the registry to prevent recording file losses in case that your Session Record‑
ing Server might fail unexpectedly. Log on as an administrator to the machine where you
installed the Session Recording Agent, open the Registry Editor, and add a DWORD value
DefaultRecordActionOnError =1 under HKEY_LOCAL_MACHINE\SOFTWARE\
Citrix\SmartAuditor\Agent.

Recording policies

You can activate system‑defined recording policies available when Session Recording is installed or
create and activate your own custom recording policies. System‑defined recording policies apply
a single rule to all users, published applications, and servers. Custom recording policies specifying
which users, published applications, and servers are recorded.

The active recording policy determines which sessions are recorded. Only one recording policy is ac‑
tive at a time.

System‑defined recording policies

Session Recording provides the following system‑defined recording policies:

• Donot record. Thedefault policy. If youdonot specify another policy, no sessions are recorded.
• Record everyonewith notification. If you choose this policy, all sessions are recorded. A pop‑
up window appears to notify recording occurrence.

• Record everyonewithout notification. If you choose this policy, all sessions are recorded. No
pop‑up window appears to notify recording occurrence.

You cannot modify or delete the system‑defined recording policies.
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Create a custom recording policy

When you create your own recording policy, you make rules to specify which users or groups, pub‑
lished applications or desktops, delivery groups or VDAmachines, and Citrix Workspace app client IP
addresses have their sessions recorded. A wizard within the Session Recording Policy Console helps
you create rules. Toobtain the list of publishedapplicationsor desktops and the list of delivery groups
or VDA machines, you must have the read permission as a Site administrator. Configure the adminis‑
trator read permission on the Delivery Controller of the Site.

For each rule you create, you specify a recording action and rule criteria. The recording action applies
to sessions that meet the rule criteria.

For each rule, choose one recording action:

• Do not record. (Choose Disable session recording in the Ruleswizard.) This recording action
specifies that sessions meeting the rule criteria are not recorded.

• Record with notification. (Choose Enable session recording with notification in the Rules
wizard.) This recording action specifies that sessions meeting the rule criteria are recorded. A
pop‑up window appears to notify recording occurrence.

• Record without notification. (Choose Enable session recording without notification in
the Rules wizard.) This recording action specifies that sessions meeting the rule criteria are
recorded. Users are unaware that they are being recorded.

For each rule, choose at least one of the following items to create the rule criteria:

• UsersorGroups. Creates a list of usersor groups towhich theactionof the rule applies. Session
Recording allows you to use Active Directory groups and white list users.

• Published Applications or Desktop. Creates a list of published applications or desktops to
which the action of the rule applies. In the Rules wizard, choose the Citrix Virtual Apps and
Desktops Site or Sites on which the applications or desktops are available.

• DeliveryGroupsorMachines. Creates a list of DeliveryGroupsormachines towhich the action
of the rule applies. In theRuleswizard, choose the location of the Delivery Groups ormachines.

• IP Address or IP Range. Creates a list of IP addresses or ranges of IP addresses to which the
action of the rule applies. On theSelect IP Address and IPRange screen, add a valid IP address
or IP range forwhich recording is enabled or disabled. The IP addressesmentioned here are the
IP addresses of the Citrix Workspace apps.

Note:

The Session Recording Policy Console supports configuringmultiple criteria within a single rule.
When a rule applies, both the “AND”and the “OR”logical operators are used to compute the fi‑
nal action. Generally speaking, the “OR”operator is used between items within a criterion, and
the “AND”operator is used between separate criteria. If the result is true, the Session Recording
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policy engine takes the rule’s action. Otherwise, it goes to the next rule and repeats the process.

When you createmore than one rule in a recording policy, some sessions might match the criteria for
more than one rule. In these cases, the rule with the highest priority is applied to the sessions.

The recording action of a rule determines its priority:

• Rules with the Do not record action have the highest priority
• Rules with the Record with notification action have the next highest priority
• Rules with the Record without notification action have the lowest priority

Some sessionsmight notmeet any rule criteria in a recording policy. For these sessions, the action of
the policy fallback rule applies. The action of the fallback rule is always Do not record. You cannot
modify or delete the fallback rule.

To create a custom recording policy:

1. Log on as an authorized Policy Administrator to the server where the Session Recording Policy
Console is installed.

2. Start the Session Recording Policy Console and selectRecordingPolicies in the left pane. From
themenu bar, choose Add New Policy.

3. Right‑click theNew policy and select Add Rule.

4. Select a recording option ‑ In the Ruleswizard, select Disable session recording, Enable Ses‑
sion Recording with notification (orwithout notification), and then clickNext.

5. Select the rule criteria ‑ You can choose one or more rule criteria:
Users or Groups
Published Applications or Desktop
Delivery Groups or Machines
IP Address or IP Range

6. Edit the rule criteria ‑ To edit, click the underlined values. The values are underlined based on
the criteria you chose in the previous step.

Note:

If you choose the Published Applications or Desktop underlined value, the Site Address
is the IP address, a URL, or a machine name if the Controller is on a local network. The
Name of Application list shows the display name.

When choosing Published Applications or Desktop or Delivery Groups or Machines, specify
the Delivery Controller for your Session Recording Policy Console to communicate with.

The Session Recording Policy Console is the only channel to communicate with Delivery Con‑
trollers from the Citrix Cloud and on‑premises environments.
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For example, when choosing Delivery Groups or Machines, click the corresponding hyperlink
in Step 3 of the preceding screenshot and click Add to add queries to the Controller.
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For a description of use cases that cover the on‑premises and the Citrix Cloud Delivery Con‑
trollers, see the following table:

Use Case Action Required

On‑Premises Delivery Controller
a) Install Broker_PowerShellSnapIn_x64.msi.

2. Clear the Citrix Cloud Controller check
box.

Citrix Cloud Delivery Controller
a) Install the Citrix Virtual Apps and Desktops

Remote PowerShell SDK. 2. Validate the
Citrix Cloud account credentials. 3. Select
the Citrix Cloud Controller check box.

Switch from an on‑premises Delivery Controller
to a Citrix Cloud Delivery Controller

a) Uninstall
Broker_PowerShellSnapIn_x64.msi and
restart the machine. 2. Install the Citrix
Virtual Apps and Desktops Remote
PowerShell SDK. 3. Validate the Citrix
Cloud account credentials. 4. Select the
Citrix Cloud Controller check box.
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Use Case Action Required

Switch from a Citrix Cloud Delivery Controller to
an on‑premises Delivery Controller

a) Uninstall the Citrix Virtual Apps and
Desktops Remote PowerShell SDK and
restart the machine. 2. Install
Broker_PowerShellSnapIn_x64.msi. 3.
Clear the Citrix Cloud Controller check
box.

Validating the Citrix Cloud credentials

To query Delivery Controllers hosted in the Citrix Cloud, manually validate your Citrix Cloud
credentials on the machine where the Session Recording Policy Console is installed. Failure
to comply can cause an error and your Session Recording Policy Console might not work as
expected.

To do the manual validation:

a) Log on to the Citrix Cloud console and locate Identity and Access Management > API
Access. Create an API access Secure Client for obtaining an authentication profile that can
bypass the Citrix Cloud authentication prompts. Download your Secure Client, rename,
and save it in a safe location. The file name is defaulted to secureclient.csv.

b) Open a PowerShell session and run the following command to have the authentication
profile (obtained in the preceding step) take effect.

1 asnp citrix.*
2 Set-XDCredentials -CustomerId "citrixdemo" -SecureClientFile "

c:\temp\secureclient.csv" -ProfileType CloudAPI – StoreAs "
default"

3
4 <!--NeedCopy-->

Set CustomerId and SecureClientFile as required. The preceding command creates a
default authentication profile for the customer citrixdemo to bypass authentication
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prompts in the current and all subsequent PowerShell sessions.

7. Follow the wizard to finish the configuration.

Note: Limitation regarding prelaunched application sessions:

• If the active policy tries to match an application name, the applications launched in the
prelaunched session are not matched, which results in the session not being recorded.

• If the active policy records every application, when a user logs on to Citrix Workspace app
for Windows (at the same time that a prelaunched session is established), a recording noti‑
fication appears and the prelaunched (empty) session and any applications to be launched
in that session going forward are recorded.

As a workaround, publish applications in separate Delivery Groups according to their recording
policies. Donotuseanapplicationnameasa recordingcondition. This ensures thatprelaunched
sessions can be recorded. However, notifications still appear.

Use Active Directory groups Session Recording allows you to use Active Directory groups when
creating policies. Using Active Directory groups instead of individual users simplifies the creation and
management of rules and policies. For example, if users in your company’s finance department are
contained in an Active Directory group named Finance, you can create a rule that applies to all mem‑
bers of this group by selecting the Finance group in the
Ruleswizard when creating the rule.

White list users You can create Session Recording policies ensuring that the sessions of some users
in your organization are never recorded. This case is called
white listing these users. White listing is useful for users who handle privacy‑related information or
when your organization does not want to record the sessions of a certain class of employees.

For example, if all managers in your company are members of an Active Directory group named Exec‑
utive, you can ensure that sessions of these users are never recorded by creating a rule that disables
session recording for the Executive group. While the policy containing this rule is active, no sessions
ofmembers of the Executive group are recorded. The sessions of othermembers of your organization
are sessions recorded based on other rules in the active policy.

Configure Director to use the Session Recording Server

You can use the Director console to create and activate the recording policies.

1. For an HTTPS connection, install the certificate to trust the Session Recording Server in the
Trusted Root Certificates of the Director server.
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2. Toconfigure theDirector server touse theSessionRecordingServer, run theC:\inetpub\wwwroot\Director\tools\DirectorConfig.exe
/configsessionrecording command.

3. Type the IP address or FQDN of the Session Recording Server and the port number and con‑
nection type (HTTP/HTTPS) that the Session Recording Agent uses to connect to the Session
Recording Broker on the Director server.

Event logging policies

Session Recording supports centralized configuration of event logging policies. You can create poli‑
cies in the Session Recording Policy Console to log various events.

Note:

To log the insertionofUSBmass storagedevices and theapplication starts andends, upgrade the
Session Recording Administration components (Session RecordingDatabase, Session Recording
Server, and Session Recording Policy Console) and the Session Recording Agent to Version 1811
or later.
To log file operation events and web browsing activities, upgrade the Session Recording Ad‑
ministration components (Session Recording Database, Session Recording Server, and Session
Recording Policy Console) and the Session Recording Agent to Version 1903 or later.

System‑defined event logging policy

The system‑defined event logging policy is Do not log. It is inactive by default. When it is active, no
events are logged.

You cannot modify or delete the system‑defined event logging policy.

Create a custom event logging policy

When you create your own event logging policy, youmake rules to specify which users or groups, pub‑
lished applications or desktops, delivery groups or VDAmachines, and Citrix Workspace app client IP
addresses have specific events logged during session recording. A wizard within the Session Record‑
ing Policy Console helps you create rules. To obtain the list of published applications or desktops and
the list of delivery groups or VDAmachines, youmust have the readpermission as a Site administrator.
Configure the administrator read permission on the Delivery Controller of the Site.

To create a custom event logging policy:

1. Log on as an authorized Policy Administrator to the server where the Session Recording Policy
Console is installed.
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2. Start the Session Recording Policy Console.
By default, there is no active event logging policy.

3. Select Event Logging Policies in the left pane. From the menu bar, choose Add New Policy to
create an event logging policy.

4. (Optional) Right‑click the new event logging policy and rename it.

5. Right‑click the new event logging policy and select Add Rule.

a) Specify one ormore target events tomonitor by selecting the check box next to each event
type.
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• Log CDM mapped USB events: Logs the insertion of a Client Drive Mapping (CDM)
mapped mass storage device in a client device where Citrix Workspace app for Win‑
dows or for Mac is installed, and tags the event in the recording.

• Log generic redirected USB events: Logs the insertion of a generic redirected mass
storage device in a client device where Citrix Workspace app for Windows or for Mac
is installed, and tags the event in the recording.

• Log app start events: Logs the starts of target applications and tags the event in the
recording.

• Log app end events: Logs the ends of target applications and tags the event in the
recording.

Note:

Session Recording cannot log the end of an application without logging its start.
Therefore, in the Rules wizard, the Log app end events check box is grayed out
before you select Log app start events.

• Appmonitoring list: When you selectLogapp start events and Logappendevents,
use the Appmonitoring list to specify target applications tomonitor and to avoid an
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excessive number of events from flooding the recordings. No application is specified
by default, which means no application is captured by default.

Note:

– To capture the start and end of an application, add the process name of the
application in theAppmonitoring list. For example, to capture the start of Re‑
mote Desktop Connection, add the process namemstsc.exe in the Appmoni‑
toring list. When you add a process to the Appmonitoring list, applications
driven by the added process and its child processes are all monitored.

– Separate process names with a semicolon (;).
– Only exact match is supported. Wildcards are not supported.
– Process names you add are case‑insensitive.
– To avoid an excessive number of events from flooding the recordings, do not
add any system process names (for example, explorer.exe) and web browsers
in the registry.

• Log sensitive file events: Logs the operations on target files in the recording.

• File monitoring list: When you select Log sensitive file events, use the File moni‑
toring list to specify target files tomonitor. You can specify folders to capture all files
within them. No file is specified by default, whichmeans no file is captured by default.

Note:

– To capture renaming, creation, deletion, or moving operations on a file, add
the path string of the file folder (not the file name or the root path of the
file folder) in the File monitoring list. For example, to capture renaming,
creation, deletion, and moving operations on the sharing.ppt file in C:\
User\File, add the path string C:\User\File in the File monitoring
list.

– Both local file paths and remote shared folder paths are supported. For exam‑
ple, to capture operations on the RemoteDocument.txt file in the \\remote
.address\Documents folder, add the path string \\remote.address
\Documents in the File monitoring list.

– Separate monitored paths with a semicolon (;).
– Only exact matches are supported. Wildcards are not supported.
– Path strings are case‑insensitive.

Limitations:

– Copying files or folders from amonitored folder to an unmonitored folder cannot
be captured.
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– When the length of a file or folder path including the file or folder name exceeds
the maximum length (260 characters), operations on the file or folder cannot be
captured.

– Payattention to thedatabase size. Toprevent largenumbers of events frombeing
captured, back up or delete the “Event”table regularly.

– When large numbers of events are captured at time intervals, the Player displays
and the database stores only one event item for each event type to avoid storage
expansion.

• Log web browsing activities: Logs user activities on supported browsers and tags
the browser name, URL, and page title in the recording.

List of supported browsers:

Browser Version

Chrome 69 and later

Internet Explorer 11

Firefox 61 and later

• Log top‑most window activities: Logs top‑most window activities and tags the
process name, title, and process number in the recording.

b) Select and edit the rule criteria.
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Similar to creating a custom recording policy, you can choose one or more rule criteria:
Users or Groups, Published Applications or Desktop, Delivery Groups or Machines,
and IP Address or IP Range. For more information, see the instructions in the Create a
custom recording policy section.

Note:

Some sessions might not meet any rule criteria in an event logging policy. For these
sessions, the event logging action of the fallback rule applies, which is alwaysDonot
log. You cannot modify or delete the fallback rule.

c) Follow the wizard to complete the configuration.

Compatibility with registry configurations

When Session Recording is newly installed or upgraded, no active event logging policy is avail‑
able by default. At this time, each Session Recording Agent respects the registry values under
HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\SessionEvents to determine whether to log
specific events. For a description of the registry values, see the following table:
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Registry Value Description

EnableSessionEvents 1: enables event logging globally; 0: disables
event logging globally (default value data).

EnableCDMUSBDriveEvents 1: enables logging the insertion of CDMmapped
USBmass storage devices; 0: disables logging
the insertion of CDMmapped USBmass storage
devices (default value data).

EnableGenericUSBDriveEvents 1: enables logging the insertion of generic
redirected USBmass storage devices; 0: disables
logging the insertion of generic redirected USB
mass storage devices (default value data).

EnableAppLaunchEvents 1: enables logging only application starts; 2:
enables logging both application starts and
ends; 0: disables logging application starts and
ends (default value data).

AppMonitorList Specifies target applications to monitor. No
application is specified by default, which means
no application is captured by default.

EnableFileOperationMonitorEvents 1: enables logging file operations; 0: disables
logging file operations (default value data).

FileOperationMonitorList Specifies target folders to monitor. No folder is
specified by default, which means no file
operation is captured by default.

EnableWebBrowsingActivities 1: enables logging web browsing activities; 0:
disables logging web browsing activities (default
value data).

Here are some compatible scenarios:

• Session Recording 1912 is newly installed or upgraded from a previous release (earlier than
1811) that does not support event logging, the related registry values on each Session Record‑
ing Agent are the default. Because there is no active event logging policy by default, no events
are logged.

• If Session Recording 1912 is upgraded from a previous release (earlier than 1811) that supports
event logging but has the feature disabled before your upgrade, the related registry values on
each Session Recording Agent remain the default. Because there is no active event logging pol‑
icy by default, no events are logged.
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• If Session Recording 1912 is upgraded from a previous release (earlier than 1811) that supports
event logging and has the feature partially or fully enabled before your upgrade, the related
registry values on each Session Recording Agent remain the same. Because there is no active
event logging policy by default, the event logging behavior remains the same.

• If Session Recording 1912 is upgraded from 1811, the event logging policies configured in the
Policy Console remain in use.

Caution:

When you activate the system‑defined or a customevent logging policy in the Session Recording
Policy Console, the relevant registry settings on each Session Recording Agent are ignored and
you cannot use registry settings for event logging any longer.

Recording viewing policies

The Session Recording Player supports role‑based access control. You can create recording viewing
policies in theSessionRecordingPolicyConsole andaddmultiple rules to eachpolicy. Each ruledeter‑
mines which user or user group can view the recordings originating fromother users and user groups,
published applications and desktops, and delivery groups and VDAs you specify.

Create a custom recording viewing policy

Before you can create recording viewing policies, enable the feature as follows:

1. Log on to the machine hosting the Session Recording Server.

2. From the Startmenu, choose Session Recording Server Properties.

3. In Session Recording Server Properties, click the RBAC tab.

4. Select the Allow to configure recording viewing policies check box.
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To create a custom recording viewing policy:

Note: Different from recording policies and event logging policies, a recording viewing policy (includ‑
ing all rules added within) is active immediately when it is created. You do not have to activate it.

1. Log on as an authorized Policy Administrator to the server where the Session Recording Policy
Console is installed.

2. Start the Session Recording Policy Console. By default, there is no recording viewing policy.
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Note: The Recording Viewing Policiesmenu is not available unless you have enabled the fea‑
ture in Session Recording Server Properties.

3. SelectRecordingViewingPolicies in the leftpane. Fromthemenubar, chooseAddNewPolicy
to create a recording viewing policy.

4. (Optional) Right‑click the new policy and rename it.
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5. Right‑click the new policy and select Add rule.

a) Specify which user or user group can view the recordings originating fromother users and
user groups you specify.
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Note:

In each rule, you can select only one user or user group as the recording viewer. If you
selectmultiple users or user groups, only yourmost recent selection takes effect and
appears in the text box.
When you specify a recording viewer, ensure that you have assigned the viewer to the
Player role. A userwithout the permission to play recorded sessions receives an error
messagewhen trying toplay a recorded session. Formore information, seeAuthorize
users.

b) Select and edit the rule criteria to specify whose recordings can be viewed by the viewer
specified earlier:

• Users or Groups
• Published Applications or Desktop
• Delivery Groups or Machines
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Note: If you leave the rule criteria unspecified, the viewer specified earlier has no record‑
ings to view.

c) Follow the wizard to complete the configuration.
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Activate a policy

1. Log on as an administrator to the machine where you installed the Session Recording Policy
Console.

2. Start the Session Recording Policy Console.
3. If the Connect to Session Recording Serverwindow appears, ensure that the name of the Ses‑

sion Recording Server, protocol, and port are correct. ClickOK.
4. In the Session Recording Policy Console, expandRecordingPoliciesorEvent LoggingPolicies

as required.
5. Select the policy to activate.
6. From themenu bar, choose Activate Policy.

Modify a policy

1. Log on as an administrator to the machine where you installed the Session Recording Policy
Console.
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2. Start the Session Recording Policy Console.
3. If the Connect to Session Recording Serverwindow appears, ensure that the name of the Ses‑

sion Recording Server, protocol, and port are correct. ClickOK.
4. In the Session Recording Policy Console, expandRecordingPoliciesorEvent LoggingPolicies

as required.
5. Select the policy you want to modify. The rules for the policy appear in the right pane.
6. To add, modify, or delete a rule:

• From the menu bar, choose Add New Rule. If the policy is active, a pop‑up window ap‑
pears requesting confirmation of the action. Use the Ruleswizard to create a rule.

• Select the rule you want tomodify, right‑click, and choose Properties. Use the Ruleswiz‑
ard to modify the rule.

• Select the rule you want to delete, right‑click, and choose Delete Rule.

Delete a policy

Note:

You cannot delete a system‑defined policy or a policy that is active.

1. Log on as an administrator to the machine where you installed the Session Recording Policy
Console.

2. Start the Session Recording Policy Console.
3. If the Connect to Session Recording Serverwindow appears, ensure that the name of the Ses‑

sion Recording Server, protocol, and port are correct. ClickOK.
4. In the Session Recording Policy Console, expandRecordingPoliciesorEvent LoggingPolicies

as required.
5. In the left pane, select the policy to delete. If the policy is active, you must activate another

policy.
6. From themenu bar, choose Delete Policy.
7. Select Yes to confirm the action.

Understand rollover behavior

When you activate a policy, the previously active policy remains in effect until the session being
recorded ends or the session recording file rolls over. Files roll over when they have reached the
maximum size. Formore information about themaximum file size for recordings, see Specify file size
for recordings.

The following table details what happens when you apply a new recording policy while a session is
being recorded and a rollover occurs:
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If the previous recording policy
was And the new recording policy is

After a rollover, the recording
policy will be

Do not record Any other policy No change. The new policy
takes effect only when the user
logs on to a new session.

Record without notification Do not record Recording stops.

Record without notification Record with notification Recording continues and a
notification message appears.

Record with notification Do not record Recording stops.

Record with notification Record without notification Recording continues. No
message appears the next time
a user logs on.

Specify where recordings are stored

April 3, 2023

Use Session Recording Server Properties to specify where recordings are stored and where archived
recordings are restored for playback.

Note:

To archive files or restore deleted files, use the ICLDB command.

Specify directories for storing recordings

By default, recordings are stored in the drive:\SessionRecordings directory of the machine hosting
theSessionRecordingServer. You canchange thedirectorywhere the recordings are stored, addextra
directories to load‑balance across multiple volumes, or make use of more space. Multiple directories
in the list indicate that recordings are load‑balanced across the directories. You can add a directory
multiple times. Load balancing cycles through the directories.

1. Log on to the machine hosting the Session Recording Server.
2. From the Startmenu, choose Session Recording Server Properties.
3. In Session Recording Server Properties, click the Storage tab.
4. Use the File storage directories list to manage the directories where recordings are stored.
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After you select the directories, Session Recording grants its service with Full Control permission to
these directories.

You can create file storage directories on the local drive, the SAN volume, or a location specified by a
UNC network path.

Note:

• Storing data on a NAS, based on file‑based protocols such as SMB and NFS, might have
performance and security implications. Use the latest version of the protocol in place to
avoid security implications and perform scale testing to ensure proper performance.

• To archive files or restore deleted files, use the ICLDB command.

Specify a directory for restoring archived recordings for playback

By default, archived recordings are restored in the drive:\SessionRecordingsRestore directory of the
computer hosting the Session Recording Server. You can change the directory.

1. Log on to the computer hosting the Session Recording Server.
2. From the Startmenu, choose Session Recording Server Properties.
3. In Session Recording Server Properties, click the Storage tab.
4. In the Restore directory for archived files field, type your directory for restoring archived

recordings.

Specify file size for recordings

June 19, 2020

As recordings grow in size, the files can take longer to download and react more slowly when you
use the seek slider to navigate during playback. To control file size, specify a threshold limit for a
file. When the recording reaches this limit, Session Recording closes the file and opens a new one to
continue recording. This action is called a rollover.

You can specify two thresholds for a rollover:

• File size. When the file reaches the specified number of MB, Session Recording closes the file
andopens a newone. By default, files roll over after reaching 50MB. You can specify a limit from
10 MB to 1 GB.

• Duration. After the session records for the specified number of hours, the file is closed and a
new file is opened. By default, files roll over after recording for 12 hours. You can specify a limit
from one to 24 hours.
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Session Recording checks both fields to determine which event occurs first to determine when to roll
over. For example, if you specify 17MB for the file size and six hours for the duration and the recording
reaches 17MB in three hours, Session Recording reacts to the 17MB file size to close the file and open
a new one.

Toprevent the creationofmany small files, SessionRecordingdoes not roll over until at least onehour
elapses (this value is theminimumnumber that you can type) regardless of the value specified for the
file size. The exception to this rule is if the file size surpasses 1 GB.

Specify themaximum file size for recordings

1. Log on to the machine hosting the Session Recording Server.
2. From the Startmenu, choose Session Recording Server Properties.
3. In Session Recording Server Properties, click the Rollover tab.
4. Type an integer between 10 and 1,024 to specify the maximum file size in MB.
5. Type an integer between 1 and 24 to specify the maximum recording duration in hours.

Customize notificationmessages

March 20, 2024

If the active recording policy specifies that users are notified when their sessions are recorded, a no‑
tification message appears after the users type their credentials. The default notification message
is Your activity with the desktop or program(s) you recently started is being recorded. If you
object to this condition, close the desktop or program(s). The users can click OK to dismiss the
window and continue their sessions.

The default notification message appears in the language of the operating system on the VDA.

You can create custom notifications in the languages you choose. However, you can have only one
notificationmessage for each language. Your users seenotificationmessages in the languages of their
preferred local settings.

Create a notificationmessage

1. Log on to the machine hosting the Session Recording Server.
2. From the Startmenu, choose Session Recording Server Properties.
3. In Session Recording Server Properties, click the Notifications tab.
4. Click Add.
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5. Choose the language for themessage and type the newmessage. You can create only onemes‑
sage for each language.

After accepting and activating, the newmessage appears in the
language‑specific notification message box.

Enable or disable recording

June 19, 2020

You install the Session Recording Agent on multi‑session OS VDAs for which you want to record ses‑
sions. Within each Agent is a setting that enables recording for the VDA on which it is installed. After
recording is enabled, Session Recording evaluates the active recording policy that determines which
sessions are recorded.

When you install the Session Recording Agent, recording is enabled. We recommend that you disable
Session Recording on VDAs that are not recorded because they experience a small impact on perfor‑
mance, even if no recording takes place.

Enable or disable recording on a VDA

1. Log on to the server where the Session Recording Agent is installed.
2. From the Startmenu, choose Session Recording Agent Properties.
3. Under Session Recording, select or clear the Enable session recording for this VDAmachine

check box to specify whether sessions can be recorded for this VDA.
4. When prompted, restart the Session Recording Agent Service to accept the change.

Note:

When you install Session Recording, the active policy is
Do not record (no sessions are recorded on any server). To begin recording, use the
Session Recording Policy Console to activate a different policy.

Enable custom event recording

Session Recording allows you to use third‑party applications to insert custom data, known as events,
to recorded sessions. These events appear when the session is viewed using the Session Record‑
ing Player. They are part of the recorded session file and cannot be modified after the session is
recorded.
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For example, an event might contain the following text: “User opened a browser.”Each time a user
opens a browser during a session that is being recorded, the text is inserted to the recording at that
point. When the session is playedusing the SessionRecordingPlayer, the viewer can locate and count
the times that the user opened a browser by noting the number of markers that appear in the Events
and Bookmarks list in the Session Recording Player.

To insert custom events to recordings on a server:

• Use Session Recording Agent Properties to enable a setting on each server where you want
to insert custom events. Enable each server separately. You cannot globally enable all servers
in a site.

• Write applications built on the Event API that runs within each user’s Citrix Virtual Apps and
Desktops session (to inject the data into the recording).

The Session Recording installation includes an event recording COM application (API) that allows you
to insert text from third‑party applications to a recording. You can use the API from many program‑
ming languages including Visual Basic, C++, or C#. For more information, see the Knowledge Center
article CTX226844. The SessionRecording Event API .dll is installed as part of the SessionRecording in‑
stallation. Youcan find it atC:\ProgramFiles\Citrix\SessionRecording\Agent\Bin\Interop.UserApi.dll.

To enable custom event recording on a server, do the following:

1. Log on to the server where the Session Recording Agent is installed.
2. From the Startmenu, choose Session Recording Agent Properties.
3. In Session Recording Agent Properties, click the Recording tab.
4. Under Custom event recording, select the Allow third party applications to record custom

data on this server check box.

Enable or disable digital signing

January 17, 2021

If you install certificates on machines where you installed the Session Recording Server and the Ses‑
sion Recording Player, you can enhance the security of your deployment by assigning digital signa‑
tures to Session Recording.

By default, digital signing is disabled. After you select the certificate to sign the recordings, Session
Recording grants the read permission to the Session Recording Storage Manager Service.

Enable digital signing

1. Log on to the machine hosting the Session Recording Server.
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2. From the Startmenu, choose Session Recording Server Properties.
3. In Session Recording Server Properties, click the Signing tab.
4. Browse to the certificate that enables secure communication among the machines where you

installed the Session Recording components.

Disable digital signing

1. Log on to the machine hosting the Session Recording Server.
2. From the Startmenu, choose Session Recording Server Properties.
3. In Session Recording Server Properties, click the Signing tab.
4. Click Clear.

Administrator Logging

January 17, 2021

Session Recording Administrator Logging logs the following activities:

• Changes to recording policies and event logging policies on the Session Recording Policy Con‑
sole or Citrix Director.

• Changes in Session Recording Server Properties.

• Downloads of recordings in the Session Recording Player.

• Recording a session by Session Recording after policy query.

• Unauthorized attempts to access the Administrator Logging service.

Warning:

Editing the registry incorrectly can cause serious problems that might require you to reinstall
your operating system. Citrix cannot guarantee that problems resulting from the incorrect use
of Registry Editor can be solved. Use Registry Editor at your own risk. Be sure to back up the
registry before you edit it.

Disable or enable Administrator Logging

After installation, you can disable or enable the Session Recording Administrator Logging feature in
Session Recording Server Properties.
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1. As an administrator, log on to the machine where Session Recording Administrator Logging is
installed.

2. From the Startmenu, choose Session Recording Server Properties.
3. Click the Logging tab.

When Session Recording Administrator Logging is disabled, no new activities are logged. You can
query the existing logs from the web‑based UI.

Whenmandatory blocking is enabled, the following activities are blocked if the logging fails. A sys‑
tem event is also logged with an Event ID 6001:

• Changes to recording policies on the Session Recording Policy Console or Citrix Director.
• Changes in Session Recording Server Properties.

The mandatory blocking setting does not impact the recording of sessions.

Configure an Administrator Logging service account

Bydefault, Administrator Logging is runningasawebapplication in Internet InformationServices (IIS),
and its identity is Network Service. To enhance the security level, you can change the identity of this
web application to a service account or a specific domain account.

1. As an administrator, log on to the machine hosting the Session Recording Server.
2. In IIS Manager, click Application Pools.
3. In Application Pools, right‑click SessionRecordingLoggingAppPool and choose Advanced

Settings.
4. Change the attribute identity to the specific account that you want to use.
5. Grant the db_owner permission to the account for the database CitrixSessionRecordingLog‑

ging on the Microsoft SQL Server.
6. Grant the readpermission to theaccount for the registrykeyatHKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server.

Disable or enable the recording action logging

By default, Administrator Logging logs every recording action after the policy query completes. This
case might generate a large amount of loggings. To improve the performance and save the storage,
disable this kind of logging in Registry.

1. As an administrator, log on to the machine hosting the Session Recording Server.

2. Open the Registry Editor.

3. Browse toHKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server.
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4. Set the value of EnableRecordingActionLogging to:

0: disable the recording action logging
1: enable the recording action logging

Query the Administrator Logging data

Session Recording provides a web‑based UI to query all Administrator Logging data.

On the computer hosting the Session Recording Server:

1. From the Startmenu, choose Session Recording Administrator Logging.
2. Type the credentials of a LoggingReader user.

On other computers:

1. Open a web browser and visit the webpage for Administrator Logging.

• ForHTTPS:https://servername/SessionRecordingLoggingWebApplication
/, where servername is the name of themachine hosting the Session Recording Server.

• ForHTTP:http://servername/SessionRecordingLoggingWebApplication
/, where servername is the name of themachine hosting the Session Recording Server.

2. Type the credentials of a LoggingReader user.

Database high availability

January 17, 2021

Session Recording supports the following solutions for database high availability based on the Mi‑
crosoftSQLServer. Databases canautomatically fail overwhen thehardwareor softwareof aprincipal
or primary SQL Server fails, which ensures that Session Recording continues to work as expected.

• Always On availability groups

The Always On availability groups feature is a high availability and disaster‑recovery solution
that provides an enterprise‑level alternative to database mirroring. Introduced in SQL Server
2012, the Always On availability groups solutionmaximizes the availability of a set of user data‑
bases for an enterprise. It requires that the SQL Server instances reside on the Windows Server
Failover Clustering (WSFC) nodes. For more information, see Always On availability groups: a
high‑availability and disaster‑recovery solution.
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• SQL Server clustering

The Microsoft SQL clustering technology allows one server to automatically take over the tasks
and responsibilities of the server that has failed. However, setting up this solution is compli‑
cated and the automatic failover is typically slower than alternatives such as SQL Server data‑
base mirroring. For more information, see Always On Failover Cluster Instances (SQL Server).

• SQL Server database mirroring

Database mirroring ensures that an automatic failover occurs in seconds if the active database
server fails. This solution ismoreexpensive than theother twosolutionsbecause full SQLServer
licenses are required on each database server. You cannot use the SQL Server Express edition
in a mirrored environment. For more information, see Database Mirroring (SQL Server).

Methods for configuring Session Recording with database high availability

To configure Session Recording with database high availability, do either of the following:

• Install the Session Recording Server components first and then configure database high avail‑
ability for the created databases.
You can install the Session Recording Administration componentswith databases configured to
be installed on the prepared SQL Server instance. Then, configure database high availability for
the created databases.

– For Always On availability groups and clustering, you must manually change the SQL
Server instance name to the name of the availability group listener or SQL Server network
inHKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server\SmAudDatabaseInstance.

– For database mirroring, you must manually add the failover partners for databases in
HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server\DatabaseFailoverPartner
andHKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server\LoggingDatabaseFailoverPartner.

• Configure database high availability for empty databases first and then install the Session
Recording Administration components.
You can create two empty databases as the Session Recording Database and the Administrator
Logging Database in the expected primary SQL Server instance and configure high availability.
Then enter the SQL Server instance name when installing the Session Recording Server
components:

– Touse theAlwaysOnavailability groups solution, enter thenameof your availability group
listener.

– To use the database mirroring solution, enter the name of your principal SQL Server.
– To use the clustering solution, enter the network name of your SQL Server.
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Load balancing

January 20, 2021

SessionRecording supports loadbalancing across SessionRecordingServers. Touse this feature, con‑
figure load balancing on Citrix ADC so that Session Recording Servers can achieve load balancing and
automatic failover.

An enhancement has been achieved that some load balancing configurations can be synchronized
among all Session Recording Servers.

Note:

This feature requires Version 7.16 or later of the Session Recording Server and Session Recording
Agent.

Changes to Session Recording in support of load balancing:

• All Session Recording Servers share one folder to store recording files.
• All Session Recording Servers share one Session Recording Database.
• (Recommended) Install only one Session Recording Policy Console and all Session Recording
Servers share this Console.

Configure load balancing

To use this feature, perform the following steps on Citrix ADC and on the various Session Recording
components:

Configure load balancing (Citrix ADC part)

Configure loadbalancing servers Add the SessionRecording Servers to the loadbalancing servers
in Citrix ADC.

Configure load balancing services

1. Add a load balancing service for each needed protocol on each Session Recording Server.
2. (Recommended) Select the relevant protocol monitor to bind each service monitor.

Configure load balancing virtual servers

1. Create virtual servers with the same Citrix ADC VIP address based on the needed protocols and
bind the virtual servers to the relevant load balancing services.
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2. Configure persistence on each virtual server.
3. (Recommended) Choose LEASTBANDWITH or LEASTPACKETS as the load balancing method

rather than the default method (LEASTCONNECTION).
4. Create a certificate to make the HTTPS virtual server UP.

Configure load balancing (Session Recording part)

On each server where you installed the Session Recording Server, do the following

1. (Recommended) Type the same Session Recording Database name during the Session Record‑
ing Server installation.

2. If you choose the Administrator Logging feature, Citrix recommends that you type the same
Administrator Logging Database name when you install each Session Recording Server.

3. After sharing the Read/Write permission of the file storage folder with all Session Recording
Server machine accounts, change to use the file storage folder as the shared folder in Session
Recording Server Properties. For more information, see Specify where recordings are restored.

4. Addavalue to theSessionRecordingServer registrykeyatHKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server.
Value name: EnableLB
Value data: 1 (DWORD, meaning enable)

5. If you choose the HTTP or the HTTPS protocol for the Session Recording Storage Manager
message queue, create a host record for the Citrix ADC VIP address, add redirections in
C:\Windows\System32\msmq\Mapping\sample_map, and restart the Message Queuing
service.

The redirection is similar to:

1 <redirections xmlns="msmq-queue-redirections.xml">
2 <redirection>
3 <from>http://<ADCHost>*/msmq/private$/

CitrixSmAudData</from>
4 <to>http://<LocalFqdn>/msmq/private$/

CitrixSmAudData</to>
5 </redirection>
6 <redirection>
7 <from>https://<ADCHost>*/msmq/private$/

CitrixSmAudData</from>
8 <to>https://<LocalFqdn>/msmq/private$/

CitrixSmAudData</to>
9 </redirection>

10 </redirections>
11 <!--NeedCopy-->

Where <ADCHost> is the created FQDN of the Citrix ADC VIP address, and <LocalFqdn> is the
FQDN of the local host.
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6. (Recommended)After configuringoneSessionRecordingServer registry, youcanuse the follow‑
ing script to export configurations from this Server registry and import the registry to the other
Session Recording Server registries. You can also use the script to add redirection mapping for
message queuing.

1 # Copyright (c) Citrix Systems, Inc.  All rights reserved.
2 <#
3        .SYNOPSIS
4
5        This script is used to sync configurations between Session

Recording Servers for load balancing deployment.
6
7        .DESCRIPTION
8
9     Will do below kinds of actions:

10
11     1. Export values from the registry key: HKEY_LOCAL_MACHINE\

SOFTWARE\Citrix\SmartAuditor\Server to SrServerConfig.reg;
12
13     2. Import from SrServerConfig.reg and overwrite values in

registry key: HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\
Server;

14
15     3. Add redirection mapping sr_lb_map.xml in %windir%\System32\

msmq\mapping\;
16
17        3.1 sr_lb_map.xml will consist redirection rule for both

http and https, and not port specific.
18
19       .PARAMETER Action
20
21        Export - to export the registry configurations of Session

Recording Server to a registry file
22
23       Import - to import the registry configurations of Session

Recording Server from a registry file
24
25        AddRedirection - to add HTTP/HTTPS redirection for MSMQ
26
27        .PARAMETER ADCHost
28
29        The host name or FQDN of Citrix ADC.
30
31     .OUTPUTS
32
33     Exported configuration file (SrServerConfig.reg) or backup

configuration file (SrServerConfig.reg.bk)
34
35        .EXAMPLE
36
37        SrServerConfigurationSync.ps1 -Action Export
38
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39        .EXAMPLE
40
41        SrServerConfigurationSync.ps1 -Action Import
42
43        .EXAMPLE
44
45     SrServerConfigurationSync.ps1 -Action AddRedirection -ADCHost

netscaler.xd.local
46
47        .EXAMPLE
48
49     SrServerConfigurationSync.ps1 -Action Import,AddRedirection -

ADCHost netscaler.xd.local
50
51        .EXAMPLE
52
53     SrServerConfigurationSync.ps1 -Action Import,Export,

AddRedirection -ADCHost netscaler.xd.local
54
55 #>
56
57 ######################
58
59 # Parameters section #
60
61 ######################
62
63 Param(
64
65        [Parameter(Mandatory = $true)]
66
67        [ValidateSet("Export", "Import", "AddRedirection")]
68
69        [string[]] $Action,
70
71        [Parameter(Mandatory = $false)]
72
73        [string] $ADCHost
74
75 )
76
77 #############################
78
79 # Default variables section #
80
81 #############################
82
83 $SR_SERVER_REG_PATH   = "HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\

SmartAuditor\Server"
84
85 $REG_FILE_PATH        = "SrServerConfig.reg"
86
87 $REG_BACKUP_FILE_PATH = "SrServerConfig.reg.bk"
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88
89 $TEMP_REDIRECT_XML    = "sr_lb_map.xml"
90
91 $REDIRECT_XML_PATH    = "$env:windir\System32\msmq\mapping"
92
93 ############# MAIN ###############
94
95 Try
96
97 {
98
99

100        If ($Action -Contains "export") {
101
102
103               Write-Host "Exporting current Session Recording

Server Configuration to registry file: $REG_FILE_PATH ..." -
ForegroundColor Green

104
105               & REG EXPORT $SR_SERVER_REG_PATH $REG_FILE_PATH /Y
106
107               Write-Host "Finish exporting." -ForegroundColor

Green
108
109        }
110
111
112        If ($Action -Contains "import")
113
114        {
115
116
117               If (!(Test-Path $REG_FILE_PATH))
118
119               {
120
121
122                      Write-Host "No $REG_FILE_PATH founded.

Aborted." -ForegroundColor Yellow
123
124                      Exit 0
125
126               }
127
128
129               # Back up previous registry key
130
131               Write-Host "Backing up Session Recording Server

Configuration to Registry file: $REG_BACKUP_FILE_PATH ..." -
ForegroundColor Green

132
133               & REG EXPORT $SR_SERVER_REG_PATH

$REG_BACKUP_FILE_PATH /Y
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134
135               Write-Host "Importing Session Recording Server

Configuration from Registry file: $REG_FILE_PATH ..." -
ForegroundColor Green

136
137               & REG IMPORT $REG_FILE_PATH 2>$null
138
139               Write-Host "Finish importing." -ForegroundColor

Green
140
141        }
142
143
144        If ($Action -Contains "addredirection")
145
146        {
147
148
149               # Check if Citrix ADC host is given; If not, exit

normally with warning.
150
151               If(([String]::IsNullOrEmpty($ADCHost)))
152
153               {
154
155
156                      Write-Host "No Citrix ADC host name is

specified. Finish adding redirection." -ForegroundColor Yellow
157
158                      Exit 0
159
160               }
161
162
163               If (!(Test-Path $TEMP_REDIRECT_XML))
164
165               {
166
167
168                      New-Item $TEMP_REDIRECT_XML -Type file
169
170               }
171
172
173               $SysInfo = Get-WmiObject -Class Win32_ComputerSystem
174
175               $LocalFqdn = "$($SysInfo.Name).$($SysInfo.Domain)"
176
177               $RedirectXmlContent =
178
179 @"
180
181 <redirections xmlns="msmq-queue-redirections.xml">
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182
183        <redirection>
184
185               <from>http://$ADCHost*/msmq/private$/CitrixSmAudData

</from>
186
187               <to>http://$LocalFqdn/msmq/private$/CitrixSmAudData

</to>
188
189        </redirection>
190
191        <redirection>
192
193               <from>https://$ADCHost*/msmq/private$/

CitrixSmAudData</from>
194
195               <to>https://$LocalFqdn/msmq/private$/CitrixSmAudData

</to>
196
197        </redirection>
198
199 </redirections>
200
201 "@
202
203               # Don't take care of encoding
204
205               $RedirectXmlContent | Out-File -FilePath

$TEMP_REDIRECT_XML
206
207               Write-Host "Copying $TEMP_REDIRECT_XML to

$REDIRECT_XML_PATH ..." -ForegroundColor Green
208
209               Copy-Item $TEMP_REDIRECT_XML -Destination

$REDIRECT_XML_PATH
210
211               Write-Host "Restarting MSMQ service ..." -

ForegroundColor Green
212
213               Restart-Service msmq -Force
214
215               Write-Host "Finish adding HTTP/HTTPS Redirection for

MSMQ." -ForegroundColor Green
216
217        }
218
219
220        Exit 0
221
222 }
223
224
225 Catch
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226
227 {
228
229
230        Write-Host "$_.Exception.Message" -ForegroundColor Red
231
232        Exit 1
233
234 }
235
236
237 Finally
238
239 {
240
241
242        # Nothing to do
243
244 }
245
246
247 <!--NeedCopy-->

6a. Save the preceding sample code as a PowerShell script, for example, SrServerConfigura‑
tionSync.ps1.

6b. On one Session Recording Server, after configuring the EnableLB registry value, start a command
prompt as an administrator and run the powershell.exe ‑file SrServerConfigurationSync.ps1 –
Action Export,AddRedirection –ADCHost <ADCHost> command, where <ADCHost> is the created
FQDN of the Citrix ADC VIP address.

6c. After the script runs, an exported registry file named SrServerConfig.reg is generated and an
sr_lb_map.xml file is added to the C:\Windows\System32\msmq\Mapping path.

6d. On other Session Recording Servers, copy SrServerConfig.reg generated in the preceding step,
start a command prompt as an administrator, and run the powershell.exe ‑file SrServerConfigura‑
tionSync.ps1 –Action Import,AddRedirection –ADCHost<ADCHost> command,where<ADCHost>
is the created FQDN of the Citrix ADC VIP address.

6e. After the script runs, the EnableLB value is added to the other Session Recording Server registry
keys and an sr_lb_map.xml file is added to the C:\Windows\System32\msmq\Mapping path.

On the machine where you installed the Session Recording Agent, do the following in Session
Recording Agent Properties

• If you choose the HTTP or the HTTPS protocol for the Session Recording Storage Manager mes‑
sage queue, type the FQDN of the Citrix ADC VIP address in the Session Recording Server text
box.
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• If you choose the default TCP protocol for the Session Recording Storage Manager message
queue, type the Citrix ADC VIP address in the Session Recording Server text box.

On the machine where you installed the Session Recording Player, do the following Add the
Citrix ADC VIP address or its FQDN as the connected Session Recording Server.

On the SQL Server where you installed the Session Recording Database, do the following Add
all the Session Recording Server machine accounts to the shared Session Recording Database and
assign themwith the db_owner permission.

Change your communication protocol

April 29, 2020

For security reasons, Citrix does not recommend using HTTP as a communication protocol. The
Session Recording installation is configured to use HTTPS. To use HTTP instead of HTTPS, you must
change several settings.

Use HTTP as the communication protocol

1. Log on to themachine hosting the Session Recording Server and disable secure connections for
Session Recording Broker in IIS.

2. Change the protocol setting from HTTPS to HTTP in Session Recording Agent Properties on
each server where the Session Recording Agent is installed:

a) Log on to each server where the Session Recording Agent is installed.
b) From the Startmenu, choose Session Recording Agent Properties.
c) In Session Recording Agent Properties, choose the Connections tab.
d) In the Session Recording Broker area, selectHTTP from theProtocol drop‑down list and

clickOK to accept the change. If you are prompted to restart the service, click Yes.

3. Change the protocol setting from HTTPS to HTTP in the Session Recording Player settings:

a) Log on to each workstation where the Session Recording Player is installed.
b) From the Startmenu, choose Session Recording Player.
c) From the Session Recording Player menu bar, choose Tools > Options > Connections,

select the server, and chooseModify.
d) Select HTTP from the Protocol drop‑down list and click OK twice to accept the change

and exit the dialog box.
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4. Change the protocol setting from HTTPS to HTTP in the Session Recording Policy Console:

a) Log on to the server where the Session Recording Policy Console is installed.
b) From the Startmenu, choose Session Recording Policy Console.
c) SelectHTTP from theProtocoldrop‑down list andclickOK to connect. If the connection is

successful, this setting is remembered thenext time you start the SessionRecordingPolicy
Console.

Revert to HTTPS as the communication protocol

1. Log on to themachine hosting the Session Recording Server and enable secure connections for
the Session Recording Broker in IIS.

2. Change the protocol setting from HTTP to HTTPS in Session Recording Agent Properties on
each server where the Session Recording Agent is installed:

a) Log on to each server where the Session Recording Agent is installed.
b) From the Startmenu, choose Session Recording Agent Properties.
c) In Session Recording Agent Properties, choose the Connections tab.
d) In the Session Recording Broker area, select HTTPS from the Protocol drop‑down list

and clickOK to accept the change. If you are prompted to restart the service, click Yes.

3. Change the protocol setting from HTTP to HTTPS in the Session Recording Player settings:

a) Log on to each workstation where the Session Recording Player is installed.
b) From the Startmenu, choose Session Recording Player.
c) From the Session Recording Player menu bar, choose Tools > Options > Connections,

select the server, and chooseModify.
d) Select HTTPS from the Protocol drop‑down list and click OK twice to accept the change

and exit the dialog box.

4. Change the protocol setting from HTTP to HTTPS in the Session Recording Policy Console:

a) Log on to the server where the Session Recording Policy Console is installed.
b) From the Startmenu, choose Session Recording Policy Console.
c) SelectHTTPS from theProtocoldrop‑down list and clickOK to connect. If the connection

is successful, this setting is remembered the next time you start the Session Recording
Policy Console.

Configure Citrix Customer Experience Improvement Program (CEIP)

March 21, 2024
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When you participate in the Citrix Customer Experience Improvement Program (CEIP), anonymous
configuration and usage data is collected and sent to Citrix to help improve the product quality and
performance. In addition, a copy of the anonymous data is sent to Google Analytics (GA) for fast and
efficient analysis.

Settings

CEIP setting

By default, you automatically participate in CEIPwhen you install Session Recording. The first upload
of data occurs approximately seven days after you install Session Recording. To unsubscribe from
CEIP, do the following:

1. Log on to the machine hosting the Session Recording Server.

2. From the Startmenu, choose Session Recording Server Properties.

3. In Session Recording Server Properties, click the CEIP tab.

4. Clear the Participate in the Customer Experience Improvement Program check box.

5. Restart the Citrix Session Recording Analytics Service to make the setting take effect.
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GA setting

When GA is enabled, the heartbeat data between GA and the Session Recording Server is collected
every 5 hours.

Registry setting that enables or disables GA (default = 0):

Location: HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server\

Name: CeipHeartBeatDisable

Value: 1 = disabled, 0 = enabled

When unspecified, GA is enabled.

To disable GA:

1. Log on to the machine hosting the Session Recording Server.

2. Open the Registry Editor.

3. Browse toHKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server\.
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4. Add a registry value and name it CeipHeartBeatDisable.

5. Set the value data of CeipHeartBeatDisable to 1.

6. Restart the Citrix Session Recording Analytics Service to make the setting take effect.

Data collected from the Session Recording Server

The following table gives an example of the types of anonymous information collected. The data does
not contain any details that identify you as a customer.

Data Point Key Name Description

Machine GUID machine_guid Identifying the machine where
the data originates. When GA is
enabled, the heartbeat data is
sent to GA regardless of
whether CEIP is enabled.

Operating System version OS_version Text string denoting the
machine’s operating system.
When GA is enabled, the
heartbeat data is sent to GA
regardless of whether CEIP is
enabled.

Session Recording Server
version

SRS_version Text string denoting the
installed version of the Session
Recording Server. When GA is
enabled, the heartbeat data is
sent to GA regardless of
whether CEIP is enabled.

Number of application
recordings

application‑recording‑number Integer denoting the number of
application recording files. The
data is sent when both GA and
CEIP are enabled.

Number of recordings recording‑number Integer denoting the number of
both application and desktop
recording files. The data is sent
when both GA and CEIP are
enabled.
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Data Point Key Name Description

Number of dynamic recordings dynamic‑recording‑number Integer denoting the number of
dynamically recorded files. The
data is sent when both GA and
CEIP are enabled.

Number of agents hosting
recorded sessions

recorded‑agent‑number Integer denoting the number of
VDAs hosting recorded sessions.
The data is sent when both GA
and CEIP are enabled.

Number of agents hosting
recorded sessions containing
logged events

event‑logging‑enabled‑agent‑
number

Integer denoting the number of
VDAs hosting recorded sessions
that contain logged events. The
data is sent when both GA and
CEIP are enabled.

Number of recordings
containing logged events

event‑logging‑recording‑
number

Integer denoting the number of
recording files that contain
logged events. The data is sent
when both GA and CEIP are
enabled.

Administrator logging
enablement

admin‑logging‑status Digit indicating the enablement
of administrator logging. “1”
means enabled. “0”means
disabled. The data is sent when
both GA and CEIP are enabled.

Number of logged events collected‑events‑number Integer denoting the number of
logged events. The data is sent
when both GA and CEIP are
enabled.

Number of custom policies customized‑policies‑number Integer denoting the number of
custom session recording and
event logging policies. The
data is sent when both GA and
CEIP are enabled.

Load balancing enablement load‑balancing‑status Digit indicating the
enablement of load balancing.
“1”means enabled. “0”means
disabled. The data is sent when
both GA and CEIP are enabled.
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Data Point Key Name Description

Recording viewing policy
enablement

rbac‑status Digit indicating the enablement
of recording viewing policies.
“1”means enabled. “0”means
disabled. The data is sent when
both GA and CEIP are enabled.

Log events

June 21, 2024

Session Recording can log events and tag events in recordings for later search and playback. You can
easily search for events of interest from large amounts of recordings and can locate the events during
playback in the Session Recording Player.

Events that can be logged

Session Recording can log the following events:

• Insertion of USBmass storage devices

• Application starts and ends

• File renaming, creation, deletion, andmoving operations

• Web browsing activities

• Top‑most window activities

Insertion of USBmass storage devices

SessionRecording can log the insertion of a Client DriveMapping (CDM)mappedor generic redirected
USB mass storage device in a client device where Citrix Workspace app for Windows or for Mac is in‑
stalled, and can tag the event in the recording.

Note:

Currently, only the insertion of USBmass storage devices (USB Class 08) can be logged. Tomake
the feature work as expected, upgrade the Session Recording Administration components and
the Session Recording Agent to Version 1811 or later. For more information, see Event logging
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policies.

Application starts and ends

Session recording supports the logging of both application starts and ends. When you add a process
to the App monitoring list, applications driven by the added process and its child processes are all
monitored.

Note:

To make the feature work as expected, upgrade the Session Recording Administration compo‑
nents and the Session Recording Agent to Version 1811 or later. Formore information, see Event
logging policies.

File renaming, creation, deletion, andmoving operations

You can log file or subfolder renaming, creation, deletion, and moving operations in target folders,
and tag the events in the recording. For more information, see Event logging policies.

Note:

Tomake the feature work as expected, upgrade all Session Recording components including the
Session Recording Administration components, the Session Recording Agent, and the Session
Recording Player to Version 1903 or later.

Web browsing activities

You can log user activities on supported browsers and tag the events in the recording. The browser
name, URL, and page title are logged. For an example, see the following screen capture.

When you move your cursor away from a webpage that has focus, your browsing of this webpage is
taggedwithout showing thebrowser name. This feature canbeused to estimatehow longauser stays
on a webpage. For an example, see the following screen capture.

List of supported browsers:
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Browser Version

Chrome 69 and later

Internet Explorer 11

Firefox 61 and later

Note:

To make the feature work as expected, upgrade the Session Recording Administration compo‑
nents and the Session Recording Agent to Version 1906 or later. Formore information, see Event
logging policies.

Top‑most window activities

SessionRecordingcan log top‑mostwindowactivitiesand tag theevents in the recording. Theprocess
name, title, and process number are logged.

Search for and play back recordings with tagged events

Search for recordings with tagged events

The Session Recording Player allows you to perform advanced searches for recordings with tagged
events.

1. In the Session Recording Player, click Advanced Search on the tool bar or choose Tools > Ad‑
vanced Search.
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2. Define your search criteria in the Advanced Search dialog box.

The Events tab allows you to search for tagged events in sessions by Event text or Event type or
both. You can use the Events, Common, Data/Time, and Other filters in combination to search for
recordings that meet your criteria.

Note:

• The Event type list itemizes all event types that have been logged by Citrix Session Record‑
ing. Youcanselectanyoneof theevent types tosearch. SelectingAnyCitrix‑definedevent
means to search for all recordings with any type of events logged by Citrix Session Record‑
ing.

• The Event text filter supports partial match. Wildcards are not supported.
• The Event text filter is case‑insensitive whenmatching.
• For theCitrix.EventMonitor.AppStart,Citrix.EventMonitor.AppEnd,Citrix.EventMonitor.CDMUSBDriveAttach,
Citrix.EventMonitor.GenericUSBDriveAttach,Citrix.EventMonitor.FileCreate, Cit‑
rix.EventMonitor.FileDelete,Citrix.EventMonitor.FileMove,Citrix.EventMonitor.FileRename,
Citrix.EventMonitor.WebBrowsing, andCitrix.EventMonitor.TopMostevents, thewords
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App Start, App End, Client drive mapping, and File Rename do not partici‑
pate in matching when you search by Event text. Therefore, when you type App Start,
App End, Client drive mapping, or File Rename in the Event text box, no
result can be found.

Play back recordings with tagged events

When you play back a recording with events tagged, the events are present in the Events and Book‑
marks panel and show as yellow dots in the lower part of the Session Recording Player as follows:

You can use events to navigate through a recorded session, or skip to the points where the events are
tagged.

View recordings

June 18, 2020

Use the Session Recording Player to view, search, and bookmark recorded Citrix Virtual Apps and
Desktops sessions.

If sessions are recorded with the live playback feature enabled, you can view sessions that are in
progress, with a delay of 1‑2 seconds.

Sessions that have a longer duration or larger file size than the limits configured by your Session
Recording administrator appear in more than one session file.
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Note:

A Session Recording administrator must grant users the right to access the recorded sessions of
VDAs. If youaredeniedaccess to viewing sessions, contact your SessionRecording administrator.

When theSessionRecordingPlayer is installed, theSessionRecordingadministrator typically setsupa
connection between the Session Recording Player and a Session Recording Server. If this connection
is not set up, the first time you perform a search for files, you are prompted to set it up. Contact your
Session Recording administrator for setup information.

Launch the Session Recording Player

March 15, 2021

Launch the Session Recording Player

1. Log on to the workstation where the Session Recording Player is installed.

2. From the Start menu, choose Session Recording Player. The Session Recording Player ap‑
pears.

This illustration shows the Session Recording Playerwith callouts indicating itsmajor elements.
The functions of these elements are described throughout the following articles.

Display or hide window elements

The Session Recording Player has window elements that toggle on and off.

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Startmenu, choose Session Recording Player.
3. From the Session Recording Playermenu bar, choose View.
4. Choose the elements that you want to display. Selecting an element causes it to appear imme‑

diately. A check mark indicates that the element is selected.

Connect to the desired Session Recording Server

If the Session Recording administrator sets up your Session Recording Player with the ability to con‑
nect to multiple Session Recording Servers, you can select the Session Recording Server that your
Session Recording Player connects to. The Session Recording Player can connect to only one Session
Recording Server at a time.
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1. Log on to the workstation where the Session Recording Player is installed.
2. From the Startmenu, choose Session Recording Player.
3. From the Session Recording Playermenu bar, choose Tools >Options > Connections.
4. Select the Session Recording Server to which you want to connect.

Enable or disable live session playback and playback protection

October 10, 2020

Enable or disable live session playback

If sessions are recorded with the live playback feature enabled, you can view a session after or while
it is being recorded. Viewing a session that is being recorded is similar to seeing actions happening
live. However, there is actually a delay of 1‑2 seconds when the data propagates from the VDA.

Some functionality is not available when you view sessions that are not recorded completely:

• A digital signature cannot be assigned until recording is complete. If digital signing is enabled,
you can view live playback sessions, but they are not digitally signed and you cannot view cer‑
tificates until the session is completed.

• Playback protection cannot be applied until recording is complete. If playback protection is
enabled, you can view live playback sessions. But they are not encrypted until the session is
completed.

• You cannot cache a file until recording is complete.

By default, live session playback is enabled.

1. Log on to the computer hosting the Session Recording Server.
2. From the Startmenu, choose Session Recording Server Properties.
3. In Session Recording Server Properties, click the Playback tab.
4. Select or clear the Allow live session playback check box.

Enable or disable playback protection

As a security precaution, Session Recording automatically encrypts recorded files that are down‑
loaded for viewing in the Session Recording Player. This playback protection prevents recorded files
from being copied and viewed by anyone other than the user who downloaded the file. The files
cannot be played back on another workstation or by another user. Encrypted files are identified
with an .icle extension. Unencrypted files are identified with an .icl extension. The files remain
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encrypted while they reside in %localAppData%\Citrix\SessionRecording\Player\
Cache on the Session Recording Player until an authorized user opens them.

We recommend that you use HTTPS to protect the transfer of data.

By default, playback protection is enabled.

1. Log on to the machine hosting the Session Recording Server.
2. From the Startmenu, choose Session Recording Server Properties.
3. In Session Recording Server Properties, click the Playback tab.
4. Select or clear the Encrypt session recording files downloaded for playback check box.

Open and play recordings

June 18, 2020

Open recordings

You can open session recordings in the Session Recording Player in three ways:

• Perform a search using the Session Recording Player. Recorded sessions that meet the search
criteria appear in the search results area.

• Access recorded session files directly from your local disk drive or a shared drive.
• Access recorded session files from a Favorites folder.

When youopen a file thatwas recordedwithout a digital signature, awarningmessage appears telling
you that the origin and integrity of the file were not verified. If you are confident of the integrity of the
file, click Yes in the warning window to open the file.

Note:

The Administrator Logging feature of Session Recording allows you to log the downloads of
recordings in the Session Recording Player. For more information, see Administrator Logging.

Open a recording in the search results area

1. Log on to the machine where the Session Recording Player is installed.
2. From the Startmenu, choose Session Recording Player.
3. Perform a search.
4. If the search results area is not visible, select Search Results in the Workspace pane.
5. In the search results area, select the session you want to play.
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6. Do any of the following:

• Double‑click the session.
• Right‑click and select Play.
• From the Session Recording Playermenu bar, choose Play > Play.

Open a recording by accessing the file

The name of a recorded session file begins with i_, followed by a unique alphanumeric file ID and
then the .icl or .icle extension. The .icl extension denotes the recordings without playback
protection applied. The .icle extension denotes the recordings with playback protection applied.
Recorded session files are saved in a folder that incorporates the date the sessions were recorded.
For example, the file for a session recorded on December 22, 2014, is saved in the folder path
2014\12\22.

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Startmenu, choose Session Recording Player.
3. Do any of the following:

• From the Session Recording Playermenu bar, choose File>Open and browse for the file.
• Using Windows Explorer, navigate to the file and drag the file to the Playerwindow.
• Using Windows Explorer, navigate to and double‑click the file.
• If you created Favorites in theWorkspace pane, selectFavorites andopen the file from the
Favorites area in the same way you open files from the search results area.

Use favorites

Creating theFavorites folders allows you toquickly access recordings that you view frequently. These
Favorites folders reference recorded session files that are stored on your workstation or on a network
drive. You can import and export these files to other workstations and share these folders with other
Session Recording Player users.

Note:

Only userswith access rights to the SessionRecordingPlayer candownload the recorded session
files associated with the Favorites folders. Contact your Session Recording administrator for the
access rights.

To create a Favorites subfolder:

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Startmenu, choose Session Recording Player.
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3. In the Session Recording Playerwindow, select the Favorites folder in your Workspace pane.
4. From the menu bar, choose File > Folder > New Folder. A new folder appears under the Fa‑

vorites folder.
5. Type the folder name, then press Enter or click anywhere to accept the new name.

Use the other options that appear in the File > Foldermenu to delete, rename, move, copy, import,
and export the folders.

Play recordings

After you open a recorded session in the Session Recording Player, you can navigate through the
recorded sessions using these methods:

• Use the player controls to play, stop, pause, and increase or decrease playback speed.
• Use the seek slider to move forward or backward.

If you have inserted markers to the recording or if the recorded session contains custom events, you
can also navigate through the recorded session by going to those markers and events.

Note:

• During playback of a recorded session, a secondmouse pointer might appear. The second
pointer appears at the point in the recording when the user navigated within Internet Ex‑
plorer and clicked an image that was originally larger than the screen but was scaled down
automatically by Internet Explorer. While only one pointer appears during the session, two
might appear during playback.

• This version of Session Recording does not support SpeedScreen Multimedia Acceleration
and the Flash quality adjustment policy setting. When this option is enabled, playback dis‑
plays a black square.

• Whenyou recorda sessionwitha resolutionhigher thanorequal to4096x4096, theremight
be fragments in the recording appearance.

Use the player controls

You can click the player controls in the lower part of the Player window or access them by choosing
Play from the Session Recording Playermenu bar.

Player Control Function

Plays the selected session file.

Pauses playback.
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Player Control Function

Stops playback. If you click Stop, then Play, the
recording restarts at the beginning of the file.

Halves the current playback speed down to a
minimum of one‑quarter of the normal speed.

Doubles the current playback speed up to a
maximum of 32 times the normal speed.

Use the seek slider

Use the seek slider in the lower part of the Player window to jump to a different position within the
recorded session. You can drag the seek slider to the point in the recording you want to view or click
anywhere on the slider bar to move to that location.

You can also use the following keyboard keys to control the seek slider:

Keyboard Key Function

Home Seeks to the beginning.

End Seeks to the end.

Right Arrow Seeks forward five seconds.

Left Arrow Seeks backward five seconds.

Movemouse wheel one notch down Seeks forward 15 seconds.

Movemouse wheel one notch up Seeks backward 15 seconds.

Ctrl + Right Arrow Seeks forward 30 seconds.

Ctrl + Left Arrow Seeks backward 30 seconds.

Page Down Seeks forward oneminute.

Page Up Seeks backward oneminute.

Ctrl + Movemouse wheel one notch down Seeks forward 90 seconds.

Ctrl + Movemouse wheel one notch up Seeks backward 90 seconds.

Ctrl + Page Down Seeks forward six minutes.

Ctrl + Page Up Seeks backward six minutes.

To adjust the speed of the seek slider: From the Session Recording Playermenu bar, choose Tools >
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Options>Playeranddrag the slider to increaseordecrease the seek response time. A faster response
time requiresmorememory. The responsemight be slowdepending on the size of the recordings and
your machine’s hardware.

Change the playback speed

You can set the Session Recording Player to play recorded sessions in exponential increments from
one‑quarter normal playback speed to 32 times normal playback speed.

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Startmenu, choose Session Recording Player.
3. From the Session Recording Playermenu bar, choose Play > Play Speed.
4. Choose a speed option.

The speed adjusts immediately. Text indicating the exponential rate appears briefly in green in the
lower part of the Player window.

Highlight the idle periods of recorded sessions

Idle periods of a recorded session are the portions inwhich no action takes place. The Session Record‑
ing Player can highlight the idle periods of recorded sessions during playback. The option is On by
default. For more information, see Highlight idle periods.

Skip over spaces where no action occurred

Fast reviewmode allows you to set Session Recording Player to skip the portions of recorded sessions
in which no action takes place. This setting saves time for playback viewing. However, it does not
skip animated sequences suchas animatedmousepointers, flashing cursors, or displayed clockswith
second handmovements.

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Startmenu, choose Session Recording Player.
3. From the Session Recording Playermenu bar, choose Play > Fast ReviewMode.

The option toggles on and off. Each time you choose it, its status appears briefly in green in the Player
window.

Change the playback display

Options allow you to change how recorded sessions appear in the Player window. You can pan and
scale the image, show the playback in full screen, display the Player window in a separate window,
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and display a red border around the recorded session to differentiate it from the Player window back‑
ground.

Display the Player window in full screen

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Startmenu, choose Session Recording Player.
3. From the Session Recording Playermenu bar, choose View > Player Full Screen.
4. To return to the original size, press Esc or F11.

Display the Player window in a separate window

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Startmenu, choose Session Recording Player.
3. From the Session Recording Playermenu bar, choose View > Player in Separate Window. A

new window appears, containing the Player window. You can drag and resize the window.
4. To embed the Player window in the main window, choose View > Player in Separate Window,

or press F10.

Scale the session playback to fit the Player window

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Startmenu, choose Session Recording Player.
3. From the Session Recording Playermenu bar, choose Play > Panning and Scaling > Scale to

Fit.

• Scale to Fit (Fast Rendering) shrinks images while providing good quality. Images are
drawn quicker than using the High Quality option but the images and texts are not sharp.
Use this option if you are experiencing performance issues when using the High Quality
mode.

• Scale to Fit (High Quality) shrinks images while providing high quality. Using this option
can cause the images to be drawnmore slowly than the Fast Rendering option.

Pan the image

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Startmenu, choose Session Recording Player.
3. From the Session Recording Playermenu bar, choose Play > Panning and Scaling > Panning.

The pointer changes to a hand. And a small representation of the screen appears in the top right
of the Player window.

4. Drag the image. The small representation indicates where you are in the image.
5. To stop panning, choose one of the scaling options.
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Display a red border around Session Recording

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Startmenu, choose Session Recording Player.
3. From the Session Recording Playermenu bar, choose Tools >Options > Player.
4. Select the Show border around session recording check box.

If the Show border around session recording check box is not selected, you can temporarily
view the red border by clicking and holding down the left mouse button while the pointer is in
the Player window.

Highlight idle periods

April 29, 2020

Idle periods of a recorded session are the portions inwhich no action takes place. The Session Record‑
ing Player can highlight the idle periods of recorded sessions during playback. The option is On by
default.

Note: Idle periods are not highlighted when playing back live sessions with the Session Recording
Player.

To highlight the idle periods of recorded sessions, do the following:

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Startmenu, choose Session Recording Player.
3. From the Session Recording Playermenu bar, choose View > Idle Periods and select or clear

the check box.

Cache recordings

April 29, 2020

Each time you open a recorded session file, the Session Recording Player downloads the file from the
location where the recordings are stored. If you download the same files frequently, you can save
download time by caching the files on your workstation. Cached files are stored on your workstation
in this folder:

userprofile\AppData\Local\Citrix\SessionRecording\Player\Cache
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You can specify howmuch disk space is used for the cache. When the recordings fill the specified disk
space, Session Recording deletes the oldest, least used recordings to make room for new recordings.
You can empty the cache at any time to free up disk space.

Enable caching

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Startmenu, choose Session Recording Player.
3. From the Session Recording Playermenu bar, choose Tools >Options > Cache.
4. Select the Cache downloaded files on local machine check box.
5. To limit the amount of disk space used for caching, select the Limit amount of disk space to

use check box and specify the number of MB to be used for cache.
6. ClickOK.

Empty caches

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Startmenu, choose Session Recording Player.
3. From the Session Recording Playermenu bar, choose Tools >Options > Cache.
4. Select the Cache downloaded files on local machine check box.
5. In the Session Recording Player, choose Tools >Options > Cache.
6. Click Purge Cache andOK to confirm the action.

Use events and bookmarks

June 18, 2020

You can use events and bookmarks to help you navigate through recorded sessions.

Citrix‑defined events are inserted to sessions while the sessions are recorded. You can also use the
EventAPI anda third‑party application to insert customevents. Events are savedaspart of the session
file. You cannot delete or alter them using the Session Recording Player.

Bookmarks are markers you insert in a recorded session during session playback using the Ses‑
sion Recording Player. After insertion, bookmarks are associated with the recorded session until
you delete them. However, they are not saved as part of the session file but stored as sepa‑
rate .iclb files in the Bookmarks cache folder on the Session Recording Player, for example,
C:\Users\SpecificUser\AppData\Local\Citrix\SessionRecording\Player\Bookmarks, with the same
file name as the .icl recording file. To play back a recording using bookmarks on a different Player,
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copy the .iclb files to the Bookmarks cache folder on that Player. By default, each bookmark is
labeled with the text “Bookmark,”but you can change it to any text annotation up to 128 characters
long.

Events appear as yellow dots and bookmarks appear as blue squares in the lower part of the Player
window. Moving the mouse over the dots and squares displays the text label associated with them.
You can also display the events and bookmarks in the Events and Bookmarks list of the Session
Recording Player. They appear in this list with their text labels and the times in the recorded session
at which they appear, in chronological order.

You can use events and bookmarks to help you navigate through recorded sessions. By going to an
event or bookmark, you can skip to the point in the recorded session where the event or bookmark is
inserted.

Display events and bookmarks in the list

The Events and Bookmarks list displays the events and bookmarks inserted in the recorded session
that is currently playing. It can show events only, bookmarks only, or both.

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Startmenu, choose Session Recording Player.
3. Move the mouse pointer to the Events and Bookmarks list area and right‑click to display the

menu.
4. Choose Show Events Only, Show Bookmarks Only, or Show All.

Insert a bookmark

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Startmenu, choose Session Recording Player.
3. Begin playing the recorded session to which you want to add a bookmark.
4. Move the seek slider to the position where you want to insert the bookmark.
5. Move the mouse pointer to the Player window area and right‑click to display the menu.
6. Add a bookmark with the default Bookmark label or create an annotation:

• To add a bookmark with the default Bookmark label, choose Add Bookmark.
• To add a bookmark with a descriptive text label that you create, choose Add Annotation.
Type the text label you want to assign to the bookmark, up to 128 characters. ClickOK.

Add or change an annotation

After a bookmark is created, you can add an annotation to it or change its annotation.
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1. Log on to the workstation where the Session Recording Player is installed.
2. From the Startmenu, choose Session Recording Player.
3. Begin playing the recorded session containing the bookmark.
4. Ensure that the Events and Bookmarks list is displaying bookmarks.
5. Select the bookmark in the Events and Bookmarks list and right‑click to display the menu.
6. Choose Edit Annotation.
7. In the window that appears, type the new annotation and clickOK.

Delete a bookmark

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Startmenu, choose Session Recording Player.
3. Begin playing the recorded session containing the bookmark.
4. Ensure that the Events and Bookmarks list is displaying bookmarks.
5. Select the bookmark in the Events and Bookmarks list and right‑click to display the menu.
6. Choose Delete.

Go to an event or bookmark

Going to an event or bookmark causes the Session Recording Player to go to the point in the recorded
session where the event or bookmark is inserted.

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Startmenu, choose Session Recording Player.
3. Begin playing a session recording containing events or bookmarks.
4. Go to an event or bookmark:

• In the lower part of the Player window, click the dot or square representing the event or
bookmark to go to the event or bookmark.

• In the Events and Bookmarks list, double‑click the event or bookmark to go to it. To go
to the next event or bookmark, select any event or bookmark from the list, right‑click to
display the menu, and choose Seek to Bookmark.

Search for recordings

June 18, 2020
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The Session Recording Player allows you to perform quick and advanced searches and to specify op‑
tions that apply to all searches. Results of searches appear in the search results area of the Session
Recording Player.

Note:

To display all available recorded sessions, up to the maximum number of sessions that might
appear in a search, perform a search without specifying any search parameters.

Perform a quick search

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Startmenu, choose Session Recording Player.
3. Define your search criteria:

• Enter a search criterion in the Search field.
• Move the mouse pointer over the Search label to display a list of parameters to use as a
guideline.

• Click the arrow to the right of the Search field to display the text for the last 64 searches
you performed.

• Use the drop‑down list to the right of the Search field to select a period or duration speci‑
fying when the session was recorded.

4. Click the binocular icon to the right of the drop‑down list to start the search.

Perform an advanced search

Advanced searches might take up to 20 seconds to return results containing more than 150,000 enti‑
ties. Citrix recommends usingmore accurate search conditions such as a date range or user to reduce
the result number.

1. Log on to the workstation where the Session Recording Player is installed.

2. From the Startmenu, choose Session Recording Player.

3. In the Session Recording Player window, click Advanced Search on the tool bar or choose
Tools > Advanced Search.

4. Define your search criteria on the tabs of the Advanced Search dialog box:

• Common allows you to search by domain or account authority, site, group, VDA for multi‑
session OS, application, or file ID.

• Date/Time allows you to search date, day of week, and time of day.
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• Events allows you to search for Citrix‑defined and custom events that are inserted to the
sessions.

• Other allows you to search by session name, client name, client address, and recording
duration. It also allows you to specify, for this search, the maximum number of search
results displayed and whether archived files are included in the search.
When you specify search criteria, the query you are creating appears in the pane at the
bottom of the dialog box.

5. Click Search to start the search.

You can save and retrieve advanced search queries. Click Save in the Advanced Search dialog
box to save the current query. ClickOpen in theAdvancedSearchdialogbox to retrieve a saved
query. Queries are saved as files with an .isq extension.

Set search options

The Session Recording Player search options allow you to limit the maximum number of session
recordings that appear in search results and to specify whether search results include archived
session files.

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Startmenu, choose Session Recording Player.
3. From the Session Recording Playermenu bar, choose Tools >Options > Search.
4. In theMaximum result to display field, type the number of search results you want to display.

A maximum of 500 results can be displayed.
5. To set whether archived files are included in searches, select or clear Include archived files.

Session Recording web player

June 18, 2020

Overview

The web player lets you use a web browser to view and play back recordings, and configure cache
memory for storing recordings while playing. Using the web player, you can:

• Search for recordings by using filters, including host name, client name, user name, application,
client IP address, event text, event type, and time. For more information, see the View record‑
ings section in this article.
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• View and play back both live and completed recordings with tagged events listed in the right
pane. For more information, see the View recordings section in this article.

Note:

Internet Explorer, Google Chrome, and Firefox are supported.

Enable the web player

The web player is disabled by default.

• To enable the web player, start a Windows command prompt and run the <Session
Recording Server installation path>\Bin\TestPolicyAdmin.exe -
enablewebplayer command.

• To disable the web player, start a Windows command prompt and run the <Session
Recording Server installation path>\Bin\TestPolicyAdmin.exe –

disablewebplayer command.

Logon and password

The URL of the web player website is http(s)://<FQDN of Session Recording Server
>/WebPlayer. To ensure the use of HTTPS, add an SSL binding to thewebsite on IIS and update the
SsRecWebSocketServer.exe.config configuration file. Formore information, see theHTTPS
configuration section in this article.

Note:

When logging on to theweb player website, domain users do not need to enter credentials while
non‑domain users must.

After you log on to the web player website, all recordings appear, listed. Clicking All Recordings in
the left navigation refreshes the page and displays new recordings if there are any.
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Installation

As with the other Session Recording components, you can use the Citrix Virtual Apps and Desktops
installer to install the web player.

During installation, selecting Session Recording Administration on the Core Components page in‑
stalls the web player on the samemachine with the Session Recording Server. For more information
about installing Session Recording, see Install, upgrade, and uninstall.

With the web player installed, the SessionRecordingRestApiService and the WebPlayer applica‑
tions appear on IIS.
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HTTPS configuration

To use HTTPS to access the web player website:

1. Add an SSL binding on IIS.

a) Obtain an SSL certificate in PEM format from a trusted Certificate Authority (CA).

Note:

Most popular browsers such as Google Chrome and Firefox no longer support the
common name in a Certificate Signing Request (CSR). They enforce Subject Alterna‑
tive Name (SAN) in all publicly trusted certificates. To use theweb player over HTTPS,
take the following actions accordingly:

• When a single Session Recording Server is in use, update the certificate of the
Session Recording Server to a SAN certificate.
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• When load balancing is in use, ensure that a SAN certificate is available both on
Citrix ADC and each Session Recording Server.

b) On IIS, right‑click the website and select Add Bindings. The Site Bindings dialog box ap‑
pears.
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c) Click Add in the upper right corner. The Add Site Binding dialog box appears.

d) Select https from the Type list and select your SSL certificate.

e) Click OK.

2. Update the SsRecWebSocketServer.exe.config configuration file.

a) Locate and open the SsRecWebSocketServer.exe.config configuration file.

The SsRecWebSocketServer.exe.config configuration file is typically located in
the <Session Recording Server installation path>\Bin\ folder.
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b) Enable TLS by editing TLSEnable=1, and fill in the paths to the SSL certificate and its key,
respectively.

Note:

Only the PEM format of SSL certificates and key files is supported.
The ServerPort field indicates the port number that the web player uses to collect
recording files. In the following screen capture, it is set to the default value (22334).

To extract the separate certificate andkey files used in theWebSocket server configuration:

i. Ensure that OpenSSL is installed on your Session Recording Server that contains the
SSL certificate.

ii. Export the SSL certificate as a .pfx file. The .pfx file includes both the certificate and
the private key.

iii. Open the command prompt and go to the folder that contains the .pfx file.

iv. Start OpenSSL from the OpenSSL\bin folder.

v. Run the following command to extract the certificate:

1 openssl pkcs12 -in [yourfile.pfx] -clcerts -nokeys -out [
aSRS2.pem]

2 <!--NeedCopy-->

Enter the import password that you created when exporting the .pfx file.

vi. Run the following command to extract the private key:

1 openssl pkcs12 -in [yourfile.pfx] -nocerts -out [
newaSRS2keyWithPassword.pem]
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2 <!--NeedCopy-->

Enter the import password that you created when exporting the .pfx file. Provide a
new password for protecting your key file when prompted for the PEM pass phrase.

vii. Run the following command to decrypt the private key:

1 openssl rsa -in [newaSRS2keyWithPassword.pem] -out [
newaSRS2key.pem]

2 <!--NeedCopy-->

c) Save your changes.

d) Check your firewall settings. Allow SsRecWebSocketServer.exe to use the TCP port (22334
by default) and allow access to the web player URL.

e) Run the TestPolicyAdmin –stopwebsocketserver command.

View recordings

After you log on to thewebplayer, all available recordings are listed. You can scroll down thewebpage
to select recordings to view or use filters to customize your search results. For live recordings, the
Duration item shows Live and the play button appears green.

For a description of the recording items, see the following table.

Item Description

Start time The recording start time. Click the up and down
arrows to list recordings in chronological order.

User The user whose session was recorded. Click the
up and down arrows to concentrate recordings
of a user on the list and arrange users in
alphabetical order.
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Item Description

Host The host name of the VDA where the recorded
session was hosted. Click the up and down
arrows to arrange the VDA host names in
alphabetical order.

Client The name of the client device where the session
was running. Click the up and down arrows to
arrange the client host names in alphabetical
order.

Events The quantity of events in the recording. Click the
up and down arrows to arrange recordings on
the list by event quantity.

Duration The time length of the recording. Click the up
and down arrows to arrange recordings on the
list by time length.

Search for recordings by using filters

You can search for recordings by using filters. The available filters include host name, client name,
user name, application, client IP address, event text, event type, and time.

For example, after you select the host name filter, the following dialog box appears. You can type in
thehost name (of the VDAwhere recorded sessions are hosted) and clickSearch to filter out irrelevant
recordings and display only the relevant ones.
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You can change to a different filter by clicking the currently selected Host name, as shown in the
following screen capture. All filters are listed after you click Host name. Select a different filter as
needed.

You can also click the + symbol to add filters.

For example, you can add the Time filter as shown in the following screen.

The Time filter consists of recording start date, start time, and duration.
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Open and play recordings

On the recordings page, each recording has a play button on the right side, next to the Duration
item.

Click the play button. The playback page appears. Playback starts after memory caching.

For a description of the player controls, see the following table:
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Player Control Description

Plays the selected recording file.

Pauses playback.

You can drag the progress bar during playback.

Seeks backward 7 seconds.

Indicates the current position of the recording
playback and the total recording duration. The
time format is HH:MM:SS.

Indicates the current speed of playback. Click
the icon to switch between options including
X0.5, X1, X2, and X4.

Displays the playback in full screen.

Displays the playback within the webpage.

In the right paneof the playbackpage, the following recordingdata, event filters, and thequick search
box are available:
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• The date and time on the web player machine. In this example, JULY 23, 2019 and 19:14:24.

• The duration of the recording in playback. In this example, 00:13:41.

• The number of events in the recording. In this example, 9 EVENTS.

• The name of the user whose session was recorded.

• The host name of the VDA where the recorded session was hosted.

• The name of the client device where the session was running.

• Event filters. You can select more than one filter to search for events in the current recording.
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Click the icon to expand folded displays of events.

• Event list. Clicking an event on the list takes you to the position of the event in the recording.

• Quick search box. The search events quick search box helps to quickly narrow down a list of
events in the current recording.

Configure cachememory for storing recordings while playing

On the Configuration page of the web player, you can click the slider to set up the cachememory for
storing recordings while playing.
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Troubleshoot

April 29, 2020

The troubleshooting information contains solutions to some issues you might encounter during or
after installing the Session Recording components.

Warning:

Editing the registry incorrectly can cause serious problems that might require you to reinstall
your operating system. Citrix cannot guarantee that problems resulting from the incorrect use
of Registry Editor can be solved. Use Registry Editor at your own risk. Be sure to back up the
registry before you edit it.

Installation of Server components fails

April 29, 2020

The installation of the Session Recording Server components fails with error codes 2503 and 2502.
Resolution: Check the access control list (ACL) of folder C:\windows\Temp to ensure that the Local
Users and Groups have write permission for this folder. If not, manually add write permission.
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Test connection to the Database fails during install

April 29, 2020

When you install the Session RecordingDatabase or the Session Recording Server, the test connection
fails with the error message Database connection test failed. Please correct Database instance
name even if the database instance name is correct.

In this case, ensure that the current user has the public SQL Server role permission to correct the
permission limitation failure.

Agent cannot connect to the Server

June 5, 2024

When the Session Recording Agent cannot connect to the Session Recording Server, the Exception
caught while sending poll messages to Session Recording Broker event message is logged, fol‑
lowed by the exception text. The exception text provides reasons why the connection failed. The
reasons include:

• The underlying connection was closed. Could not establish a trust relationship for the
SSL/TLS secure channel. This exception means that the Session Recording Server is using a
certificate signed by a CA that the server hosting the Session Recording Agent does not trust or
the server hosting the Session Recording Agent does not have a CA certificate. Alternatively, the
certificate might have expired or been revoked.

Solution: Verify that the correct CA certificate is installed on the server hosting the Session
Recording Agent or use a CA that is trusted.

• The remote server returned an error: (403) forbidden. This standard HTTPS error occurs
when you attempt to connect using HTTP that is unsecure. The machine hosting the Session
Recording Server rejects the connection because it accepts only secure connections.

Solution: Use Session Recording Agent Properties to change the Session Recording Broker pro‑
tocol toHTTPS.

• The Session Recording Broker returned an unknown error while evaluating a record pol‑
icy query. Error code 5 (Access Denied). For more information, see the Event log on the
Session Recording Server. This error occurs when sessions are started and a request for a
record policy evaluation is made. The error is a result of the Authenticated Users group (the de‑
faultmember) being removed fromthePolicyQuery roleof theSessionRecordingAuthorization
Console.
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Solution: Add the Authenticated Users group back to this role, or add each server hosting each
Session Recording Agent to the PolicyQuery role.

• The underlying connection was closed. A connection that was expected to be kept alive
was closed by the server. This error means that the Session Recording Server is down or un‑
available to accept requests. The IIS might be offline or restarted, or the entire server might be
offline.

Solution: Verify that the Session Recording Server is started, IIS is running on the server, and
the server is connected to the network.

• The remote server returned an error: 401 (Unauthorized). This error manifests itself in the
following ways:

– On startup of the Session Recording Agent service, an error describing the 401 error is
recorded in the event log.

– Policy query fails on the Session Recording Agent.
– Session recordings are not captured on the Session Recording Agent.

Solution: Ensure that theNT AUTHORITY\AuthenticatedUsers group is amember of the local
Users group on the Session Recording Agent.
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Server cannot connect to the Database

September 25, 2020

When the SessionRecording Server cannot connect to the SessionRecordingDatabase, youmight see
a message similar to one of the following:

Event Source:

A network‑related or instance‑specific error occurred while establishing a connection to SQL
Server. This error appears in the applications event log with ID 2047 in the Event Viewer of the com‑
puter hosting the Session Recording Server.

Citrix Session Recording Storage Manager Description: Exception caught while establishing
database connection. This error appears in the applications event log in the Event Viewer of the
machine hosting the Session Recording Server.

Unable to connect to the Session Recording Server. Ensure that the Session Recording Server is
running. This error message appears when you launch the Session Recording Policy Console.

Resolution:

• The Express Edition of Microsoft SQL Server 2008 R2, Microsoft SQL Server 2012, Microsoft SQL
Server 2014, or Microsoft SQL Server 2016 is installed on a stand‑alone server and does not
have the correct services or settings configured for Session Recording. The server must have
the TCP/IP protocol enabled and the SQL Server Browser service running. See the Microsoft
documentation for information about enabling these settings.

• During the Session Recording installation (administration portion), incorrect server and data‑
base information was given. Uninstall the Session Recording Database and reinstall it, supply‑
ing the correct information.

• The Session Recording Database Server is down. Verify that the server has connectivity.
• The machine hosting the Session Recording Server or the machine hosting the Session Record‑
ing Database Server cannot resolve the FQDN or NetBIOS name of the other. Use the ping com‑
mand to verify that the names can be resolved.

• Check the firewall configuration on the Session Recording Database to ensure that the SQL
Server connections are allowed. Formore information, see the Microsoft article at https://docs
.microsoft.com/en‑us/sql/sql‑server/install/configure‑the‑windows‑firewall‑to‑allow‑sql‑
server‑access?redirectedfrom=MSDN&view=sql‑server‑ver15.

Logon failed for user ‘NT_AUTHORITY\ANONYMOUS LOGON’. This error message means that the
services are logged on incorrectly as .\administrator.

Resolution: Restart the services as local system user and restart the SQL services.
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Sessions are not recording

December 6, 2023

If application sessions are not recording successfully, check the application event log in the Event
Viewer on the Session Recording Agent and Session Recording Server. Doing so can provide valuable
diagnostic information.

If sessions are not recording, the possible cause might be:

• Component connectivity and certificates. If the Session Recording components cannot com‑
municate with each other, session recording can fail. To troubleshoot recording issues, verify
that all components are configured correctly to point to the correct machines and that all cer‑
tificates are valid and correctly installed.

• Non‑Active Directory domain environments. Session Recording is designed to run in a Mi‑
crosoft Active Directory domain environment. If you are not running in an Active Directory en‑
vironment, you might experience recording issues. Ensure that all Session Recording compo‑
nents are running onmachines that are members of an Active Directory domain.

• Session sharing conflictswith the active policy. Session Recordingmatches the active policy
with the first published application that a user opens. Subsequent applications opened during
the samesession continue to follow thepolicy that is in force for the first application. Toprevent
session sharing from conflicting with the active policy, publish the conflicting applications on
separate VDAs formulti‑session OS.

• Recording isnotenabled. Bydefault, installing theSessionRecordingAgentonamulti‑session
OS VDA enables recording for the VDA. Recording does not occur until an active recording policy
is configured to allow it.

• The active recording policy does not permit recording. A session can be recorded onlywhen
the session meets the rules of the active recording policy.

• Session Recording services are not running. For sessions to be recorded, the Session Record‑
ing Agent servicemust be runningonaVDA formulti‑sessionOSand theSessionRecording Stor‑
age Manager service must be running on the machine hosting the Session Recording Server.

• MSMQ is not configured. If MSMQ is not correctly configured on the server running the Session
Recording Agent and the machine hosting the Session Recording Server, recording problems
might occur.

• The Session Recording Database component is not upgraded properly. When you upgrade
an existing installation, you must follow the upgrade sequence strictly. If you have more than
one Session Recording Server in your deployment, you must first upgrade the Session Record‑
ing Server where the Session Recording Database component is installed. If not, the session

© 1999–2024 Cloud Software Group, Inc. All rights reserved. 157



Session Recording 1912 LTSR

recording fails. To correct the issue of the Session Recording Database component not being
upgraded properly, perform either of the following actions:

– Locate the Session Recording Server where the Session Recording Database component
is installed. Then run the Citrix Virtual Apps and Desktops ISO or the SessionRecordingAd‑
ministrationx64.msi package on it.

– Run the following script on any of the Session Recording Servers in your deployment.
When running the script, provide the path to the SessionRecordingAdministrationx64.msi
package as a parameter.

1 param(
2 [Parameter(Mandatory=$true)]
3 [ValidateNotNullOrEmpty()]
4 [string]$Installer
5 )
6 Add-Type -AssemblyName System.Data
7
8 if (!(Test-Path "$PSScriptRoot\bin\lessmsi.exe")) {
9

10 Write-Error "Download zip of binaries from https://github
.com/activescott/lessmsi/releases/download/v1.10.0/
lessmsi-v1.10.0.zip and extract to \bin in this folder
!"

11 exit
12 }
13
14
15 # Open MSI database
16 $msi = New-Object -ComObject WindowsInstaller.Installer
17 $msidb = $msi.OpenDatabase($Installer, 0)
18
19 # Query File table
20 $query = "SELECT Version FROM File WHERE FileName = 'SMAUDD

~1.DLL|SsRecDatabase.dll'"
21
22 $view = $msidb.OpenView($query)
23 $view.Execute()
24
25 # Get DLL version
26 $record = $view.Fetch()
27
28 $version = $record.GetType().InvokeMember("StringData", "

GetProperty", $null, $record, 1)
29 $parts = $version.Split(".")
30 [int] $major = $parts[0]
31 [int] $minor = $parts[1]
32 $majorMinor = $parts[0..1] -join "."
33 $versionCompare = $major * 100 + $minor
34
35 # Get db instance and name
36 $registryKey = [Microsoft.Win32.Registry]::LocalMachine.
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OpenSubKey("SOFTWARE\\Citrix\\SmartAuditor\\Server")
37 $dbName = $registryKey.GetValue("DatabaseName")
38 $dbInstance = $registryKey.GetValue("SmAudDatabaseInstance")
39
40
41 write-host "Upgrade db($dbInstance\$dbName) to version

$version"
42
43 $schemaVersionMap = @{
44 }
45
46 $schemaVersionMap["19.12"] = "1.2.3.0"
47 $schemaVersionMap["22.3"] = "1.3.3.0"
48 $schemaVersionMap["22.6"] = "1.3.4.0"
49 $schemaVersionMap["22.9"] = "1.3.4.0"
50 $schemaVersionMap["22.12"] = "1.3.5.0"
51 $schemaVersionMap["23.3"] = "1.3.6.0"
52 $schemaVersionMap["23.5"] = "1.3.7.0"
53 $schemaVersionMap["23.8"] = "1.3.8.0"
54
55 $DBSchemaUpdatePatchList = @(
56 "1.1.0.0",
57 "1.2.0.0",
58 "1.2.1.0",
59 "1.2.2.0",
60 "1.2.3.0",
61 "1.2.4.0",
62 "1.2.5.0",
63 "1.2.6.0",
64 "1.2.7.0",
65 "1.2.8.0",
66 "1.2.9.0",
67 "1.3.0.0",
68 "1.3.1.0",
69 "1.3.2.0",
70 "1.3.3.0",
71 "1.3.4.0",
72 "1.3.5.0",
73 "1.3.6.0",
74 "1.3.7.0",
75 "1.3.8.0"
76 )
77
78 $currentSchemaVersion = $schemaVersionMap[$majorMinor]
79
80 # Connect db
81 $conn = New-Object System.Data.SqlClient.SqlConnection
82 $conn.ConnectionString = "workstation id=.;packet size=4096;

integrated security=SSPI;data source=$dbInstance;persist
security info=True;initial catalog=$dbName"

83
84 # Open connection
85 $conn.Open()
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86
87 # Get existing db schema version
88 $cmdGetSchema = $conn.CreateCommand()
89 $cmdGetSchema.CommandType = [System.Data.CommandType]::

StoredProcedure
90 $cmdGetSchema.CommandText = "[GetSchemaVersion]"
91 $out1 = $cmdGetSchema.Parameters.Add("@Major", [System.Data.

SqlDbType]::Int)
92 $out1.Direction = [System.Data.ParameterDirection]::Output
93 $out2 = $cmdGetSchema.Parameters.Add("@Minor", [System.Data.

SqlDbType]::Int)
94 $out2.Direction = [System.Data.ParameterDirection]::Output
95 $out3 = $cmdGetSchema.Parameters.Add("@Build", [System.Data.

SqlDbType]::Int)
96 $out3.Direction = [System.Data.ParameterDirection]::Output
97 $out4 = $cmdGetSchema.Parameters.Add("@Revision", [System.

Data.SqlDbType]::Int)
98 $out4.Direction = [System.Data.ParameterDirection]::Output
99 $cmdGetSchema.ExecuteNonQuery()

100
101 $existDbSchemaVersion = [string]::Format("{
102 0 }
103 .{
104 1 }
105 .{
106 2 }
107 .{
108 3 }
109 ", $out1.Value, $out2.Value, $out3.Value, $out4.Value)
110 write-host "Existing DB Schema Version: $existDbSchemaVersion

"
111
112 if ([string]::Compare($existDbSchemaVersion,

$currentSchemaVersion) -lt 0) {
113
114 Write-Output "Upgrade $existDbSchemaVersion to

$currentSchemaVersion"
115
116 & $PSScriptRoot\bin\lessmsi.exe x $Installer

$PSScriptRoot\ SsRecDatabase.dll
117 $tempdir = "$PSScriptRoot\SOURCEDIR\Program Files\Citrix\

SessionRecording\Database\Bin"
118 # Load assembly and get resource
119 $asm = [Reflection.Assembly]::LoadFile("$tempdir\

SsRecDatabase.dll")
120
121 foreach ($patch in $DBSchemaUpdatePatchList) {
122
123 if ([string]::Compare($existDbSchemaVersion, $patch)

-le 0 -and [string]::Compare($patch,
$currentSchemaVersion) -lt 0) {

124
125 write-host "Applying $patch"
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126 # switch to db
127 $switchCmd = $conn.CreateCommand()
128 $switchCmd.CommandText = "use [$dbName]"
129 $switchCmd.ExecuteNonQuery()
130
131 $resStream = $asm.GetManifestResourceStream("

SmAudDatabase.$patch-MigrateDatabase.sql")
132 $bytes = New-Object byte[] $resStream.Length
133 $resStream.Read($bytes, 0, $resStream.Length)
134 $script = [System.Text.Encoding]::UTF8.GetString(

$bytes)
135
136 $statements = [regex]::Split($script, "\s[gG][oO

]\s")
137 foreach($statement in $statements) {
138
139 $upgradeCmd = $conn.CreateCommand()
140 $upgradeCmd.CommandText = $statement
141 $upgradeCmd.ExecuteNonQuery()
142 }
143
144
145 $existDbSchemaVersion = $patch
146 }
147 else {
148
149 write-host "Skip $patch"
150 }
151
152 }
153
154 # UpdateStaticData
155 $staticCmd = $conn.CreateCommand()
156 $staticCmd.CommandText = "use [$dbName];if not exists(

select * from [dbo].[StartReason] where ID=4) begin
insert [dbo].[StartReason] values(4, 'Event Triggered
') end"

157 $staticCmd.ExecuteNonQuery()
158
159 if ($versionCompare -ge 2308) {
160
161 # upgrade record policy version
162 $staticCmd = $conn.CreateCommand()
163 $staticCmd.CommandText = "update [dbo].[

PolicyDocument] set PolicyFileFormatMajorVersion =
1, PolicyFileFormatMinorVersion = 3 where

SystemDefined = 1"
164 $staticCmd.ExecuteNonQuery()
165
166 # upgrade endreason
167 $staticCmd = $conn.CreateCommand()
168 $staticCmd.CommandText = "if not exists(select * from

[dbo].[EndReason] where ID=5) begin insert [dbo
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].[EndReason] values(5 , 'Dormant') end"
169 $staticCmd.ExecuteNonQuery()
170 }
171
172
173 if ($versionCompare -ge 2311) {
174
175
176 # upgrade endreason
177 $staticCmd = $conn.CreateCommand()
178 $staticCmd.CommandText = "if not exists(select * from

[dbo].[EndReason] where ID=6) begin insert [dbo
].[EndReason] values(6 , 'Deny') end"

179 $staticCmd.ExecuteNonQuery()
180 }
181
182 write-host "Upgrade success!"
183 }
184
185 else {
186
187 Write-Output "Current schema version don't need upgrade"
188 }
189
190
191 $conn.Close()
192 <!--NeedCopy-->

Unable to view live session playback

April 29, 2020

If you experience difficulties when viewing recordings using the Session Recording Player, the follow‑
ing error message might appear:

Download of recorded session file failed. Live session playback is not permitted. The server
has been configured to disallow this feature. This error indicates that the server is configured to
disallow the action.

Resolution: In Session Recording Server Properties, choose the Playback tab and select the Allow
live session playback check box.
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Recordings are corrupted or incomplete

June 5, 2024

• If recordings are corrupted or incomplete when you view them using the Session Recording
Player, youmight also see warnings in the Event logs on the Session Recording Server.

Event Source: Citrix Session Recording Storage Manager

Description: Data lost while recording file <icl file name>

This issue occurs when MCS or PVS is used to create VDAs with a master image configured and
Microsoft Message Queuing (MSMQ) installed. In this condition, the VDAs have the same QMId
for MSMQ.

As aworkaround, create a uniqueQMId for eachVDA. Formore information, see Install, upgrade,
and uninstall.

• The Session Recording Playermight report an internal error with themessage ‑ “The file being
playedhas reported that an internal systemerror (error code: 9) occurredduring its origi‑
nal recording. The file can still beplayedup to thepoint that the recordingerroroccurred”
when playing back a certain recording file.

The issue occurs due to insufficient buffer size on the Session Recording Agent when graphic
intensive sessions are recorded.

Asaworkaround, changeHKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\SmAudBufferSizeMB
to higher value data on the Session Recording Agent, and then restart the machine.

Verify component connections

June 19, 2020

During the setup of Session Recording, the components might not connect to other components. All
the components communicate with the Session Recording Server (Broker). By default, the Broker (an
IIS component) is secured using the IIS default website certificate. If one component cannot connect
to the Session Recording Server, the other componentsmight also fail when attempting to connect.

The Session Recording Agent and the Session Recording Server (StorageManager andBroker) log con‑
nection errors in the applications event log in the Event Viewer of the machine hosting the Session
Recording Server. The Session Recording Policy Console and The Session Recording Player display
connection error messages on screen when they fail to connect.
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Verify that the Session Recording Agent is connected

1. Log on to the server where the Session Recording Agent is installed.
2. From the Startmenu, choose Session Recording Agent Properties.
3. In Session Recording Agent Properties, click Connection.
4. Verify that the correct FQDN is entered in the Session Recording Server field.
5. Verify that the server given as the value for the Session Recording Server is accessible to your

VDA for multi‑session OS.

Note: Check the application event log for errors and warnings.

Verify that the Session Recording Server is connected

Caution:

UsingRegistryEditor cancauseseriousproblems thatmight require you to reinstall theoperating
system. Citrix cannot guarantee that problems resulting from incorrect use of Registry Editor can
be solved. Use Registry Editor at your own risk.

1. Log on to the machine hosting the Session Recording Server.
2. Open the Registry Editor.
3. Browse to HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server.
4. Verify that theSmAudDatabaseInstance value correctly references theSessionRecordingData‑

base you installed on your SQL Server instance.

Verify that the Session Recording Database is connected

1. Using a SQL Management tool, open your SQL instance that contains the Session Recording
Database you installed.

2. Open the Security permissions of the Session Recording Database.
3. Verify that the Session Recording Computer Account has access to the database. For example,

if the machine hosting the Session Recording Server is named SsRecSrv in the MIS domain,
the computer account in your database must be configured as MIS\SsRecSrv$. This value is
configured during the Session Recording Database installation.

Test IIS connectivity

Testing connections to the Session Recording Server IIS site by using a Web browser to access the
Session Recording Broker webpage can help you determine whether problems with communication
between Session Recording components stem from misconfigured protocol configuration, certifica‑
tion issues, or problems starting Session Recording Broker.
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To verify IIS connectivity for the Session Recording Agent:

1. Log on to the server where the Session Recording Agent is installed.
2. Open a Web browser and type the following address:

• ForHTTPS:https://servername/SessionRecordingBroker/RecordPolicy
.rem?wsdl, where servername is the name of the machine hosting the Session
Recording Server.

• For HTTP: http://servername/SessionRecordingBroker/RecordPolicy.
rem?wsdl, where servername is the name of themachine hosting the Session Record‑
ing Server.

3. If you are prompted for NT LANManager (NTLM) authentication, log on with a domain adminis‑
trator account.

To verify IIS connectivity for the Session Recording Player:

1. Log on to the workstation where the Session Recording Player is installed.
2. Open a Web browser and type the following address:

• For HTTPS: https://servername/SessionRecordingBroker/Player.rem?
wsdl, where servername is the name of the machine hosting the Session Recording
Server

• For HTTP: http://servername/SessionRecordingBroker/Player.rem?
wsdl, where servername is the name of the machine hosting the Session Recording
Server

3. If you are prompted for NT LANManager (NTLM) authentication, log on with a domain adminis‑
trator account.

To verify IIS connectivity for the Session Recording Policy Console:

1. Log on to the server where the Session Recording Policy Console is installed.
2. Open a Web browser and type the following address:

• ForHTTPS:https://servername/SessionRecordingBroker/PolicyAdministration
.rem?wsdl, where servername is the name of the machine hosting the Session
Recording Server

• ForHTTP:http://servername/SessionRecordingBroker/PolicyAdministration
.rem?wsdl, where servername is the name of the machine hosting the Session
Recording Server

3. If you are prompted for NT LANManager (NTLM) authentication, log on with a domain adminis‑
trator account.
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If you see an XML document within your browser, it verifies that the machine running the Session
Recording Policy Console is connected to the machine hosting the Session Recording Server using
the configured protocol.

Troubleshoot certificate issues

If you are using HTTPS as your communication protocol, the machine hosting the Session Recording
Servermust be configuredwith a server certificate. All component connections to the SessionRecord‑
ing Server must have root certificate authority (CA). Otherwise, attempted connections between the
components fail.

You can test your certificates by accessing the Session Recording Broker webpage as youwould when
testing IIS connectivity. If you are able to access the XML page for each component, the certificates
are configured correctly.

Here are some common ways certificate issues cause connections to fail:

• Invalid or missing certificates. If the server running the Session Recording Agent does not
have a root certificate to trust the server certificate and cannot trust and connect to the Session
Recording Server over HTTPS, causing connectivity to fail, verify that all components trust the
server certificate on the Session Recording Server.

• Inconsistent naming. If the server certificate assigned to the machine hosting the Session
Recording Server is created using an FQDN, all connecting components must use the FQDN
when connecting to the Session Recording Server. If a NetBIOS name is used, configure the
components with a NetBIOS name for the Session Recording Server.

• Expiredcertificates. If a server certificateexpired, connectivity to theSessionRecordingServer
through HTTPS fails. Verify the server certificate assigned to the machine hosting the Session
Recording Server is valid and has not expired. If the same certificate is used for the digital sign‑
ing of session recordings, the event log of the machine hosting the Session Recording Server
provides error messages that the certificate expired or warning messages when it is about to
expire.

Search for recordings using the Player fails

June 19, 2020

If you experience difficulties when searching for recordings using the Session Recording Player, the
following error messages might appear:
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• Search for recorded session files failed. The remote server name could not be resolved:
servername. The servername is the name of the server towhich the Session Recording Player
is attempting to connect. The Session Recording Player cannot contact the Session Recording
Server. Two possible reasons are an incorrectly typed server name or that the DNS cannot re‑
solve the server name.

Resolution: From the Player menu bar, choose Tools > Options > Connections and verify that
the servername in theSessionRecordingServers list is correct. If it is correct, fromacommand
prompt, run the ping command to see if the name canbe resolved. When the SessionRecording
Server is down or offline, the search for recorded session files failed errormessage isUnable to
contact the remote server.

• Unable to contact the remote server. This error occurs when the Session Recording Server is
down or offline.

Resolution: Verify that the Session Recording Server is connected.

• Access denied. An access denied error can occur if the user was not given permission to search
for and download recorded session files.

Resolution: Assign the user to the Player role using the Session Recording Authorization Con‑
sole.

• Access denied when the Player role is assigned. This error occurs when you install the Ses‑
sion Recording Player on the same machine with the Session Recording Server, and you have
enabled UAC. When you assign the Domain Admins or Administrators user group as the Player
role, a non‑built‑in administrator user included in that group might fail to pass the role‑based
check when searching recording files with the Session Recording Player.

Resolutions:

– Run the Session Recording Player as administrator.

– Assign specific users as Player role rather than the entire group.

– Install the Session Recording Player in a separate machine rather than Session Recording
Server.

• Search for recorded session files failed. The underlying connectionwas closed. Could not
establish a trust relationship for the SSL/TLS secure channel. The error occurs when the
Session Recording Server uses a certificate that is signed by a CA that the client device does not
trust or have a CA certificate for.

Resolution: Install the correct or trustedCA certificateworkstationwhere theSessionRecording
Player is installed.

• The remote server returned an error: (403) forbidden. This standard HTTPS error occurs
when you attempt to connect using HTTP that is unsecure. The server rejects the connection
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because, by default, it is configured to accept only secure connections.

Resolution: From the Session Recording Playermenu bar, choose Tools >Options > Connec‑
tions. Select the server from the SessionRecording Servers list, and clickModify. Change the
protocol fromHTTP toHTTPS.

Troubleshoot MSMQ

If a notification message is given but the viewer cannot find recordings after a search in the Session
Recording Player, there is a problem with MSMQ. Verify that the queue is connected to the Session
Recording Server (StorageManager). Use aWeb browser to test for connection errors (if you are using
HTTP or HTTPS as your MSMQ communication protocol).

To verify that the queue is connected:

1. Log on to the server hosting the Session Recording Agent and view the outgoing queues.

2. Verify that the queue to the machine hosting the Session Recording Server has a connected
state.

• If the state is waiting to connect, there are messages in the queue, and the protocol is
HTTP or HTTPS (corresponding to the protocol selected on the Connections tab in Ses‑
sion Recording Agent Properties), perform Step 3.

• If the state is connectedand therearenomessages in thequeue, theremightbeaproblem
with the server hosting the Session Recording Server. Skip Step 3 and perform Step 4.

3. If there are messages in the queue, open a Web browser and type the following address:

• For HTTPS: https://servername/msmq/private$/CitrixSmAudData, where
servername is the name of the machine hosting the Session Recording Server.

• For HTTP: http://servername/msmq/private$/CitrixSmAudData, where
servername is the name of the machine hosting the Session Recording Server.

If the page returns an error such as The server only accepts secure connections, change the
MSMQ protocol listed in Session Recording Agent Properties to HTTPS. If the page reports a
problemwith thewebsite security certificate, theremight be aproblemwith a trust relationship
for the TLS secure channel. In that case, install the correct CA certificate or use a CA that is
trusted.

4. If there are no messages in the queue, log on to the machine hosting the Session Recording
Server and view private queues. Select citrixsmauddata. If there are messages in the queue
(Number of Messages Column), verify that the Session Recording StorageManager service is
started. If it is not, restart the service.
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Manage your database records

June 18, 2020

The ICA Log database (ICLDB) utility is a database command‑line utility used to manipulate the ses‑
sion recording database records. This utility is installed, during the Session Recording installation, to
the drive:\Program Files\Citrix\SessionRecording\Server\Bin folder on the server
hosting the Session Recording Server.

Quick reference chart

The following table lists the commands and options that are available for the ICLDB utility. Type the
commands using the following format:

icldb [version | locate | dormant | import | archive | remove |
removeall] command-options [/l] [/f] [/s] [/?]

Note:

More extensive instructions are available in the help associated with the utility. To access the
help, from a command prompt, type the drive:
\Program Files\Citrix\SessionRecording\Server\Bin folder, and type
icldb /?. To access help for specific commands, type
icldb *command* /?.

Command Description

archive Archives the session recording files older than
the retention period specified. Use this
command to archive files.

dormant Displays or counts the session recording files
that are considered dormant. Dormant files are
session recordings that were not completed due
to data loss. Use this command to verify if you
suspect that you are losing data. You can check
whether the session recording files are
becoming dormant for the entire database, or
only recordings made within the specified
number of days, hours, or minutes.
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Command Description

import Imports session recording files to the Session
Recording database. Use this command to
rebuild the database if you lose database
records. Also, use this command tomerge
databases (if you have two databases, you can
import the files from one of the databases).

locate Locates and displays the full path to a session
recording file using the file ID as the criteria. Use
this command when you are looking for the
storage location of a session recording file. It is
also one way to verify if the database is
up‑to‑date with a specific file.

remove Removes the references to session recording
files from the database. Use this command (with
caution) to clean up the database. Specify the
retention period to be used as the criteria. You
can also remove the associated physical file.

removeall Removes all references to session recording files
from the Session Recording Database and
returns the database to its original state. The
actual physical files are not deleted; however,
you cannot search for these files in the Session
Recording Player. Use this command (with
caution) to clean up the database. Deleted
references can be reversed only by restoring
from your backup.

version Displays the Session Recording Database
schema version.

/l Logs the results and errors to the Windows event
log.

/f Forces the command to run without prompts.

/s Suppresses the copyright message.

/? Displays help for the commands.
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Archive session recording files

Tomaintainanadequate levelof sparediskcapacity in the recordingstorage locations, archive session
recording files regularly. Depending on the amount of disk space available and the typical size of
session recording files, archiving intervals differ. Session recording files must be older than two days
from the start date before a session recording file can be archived. This rule is to prevent any live
recordings from being archived before they become complete.

Two methods are available when you archive session recordings. The database record for a session
recording file can be updated to have a status of archived while the session recording file remains
in the recording storage location. This method can be used to reduce the search results in the Player.
The othermethod is to update the database record for a session recording file to the status of archived
and also move the session recording file from the recording storage location to another location for
backup to alternativemedia. When the ICLDButilitymoves session recording files, the files aremoved
to the specified directorywhere the original file folder structure of year/month/day no longer exists.

The session recording record in the Session Recording Database contains two fields associated with
archiving: the archive time representing the current date and time a session recording was archived;
the archive note, anoptional text note thatmight be addedby the administrator during archiving. The
two fields indicate a session recording has been archived and the time of archiving.

In the Session Recording Player, any archived session recordings show a status of Archived and the
date and timeof archiving. Session recordings that havebeen archivedmight still be played if the files
have not beenmoved. If a session recording file was moved during archiving, a file not found error is
displayed. The session recording file must be restored before the session can be played. To restore a
session recording, provide the administratorwith the File ID andArchiveTimeof the session recording
from the recording Properties dialog box in the Session Recording Player. Restoring archived files is
discussed further in the following Restore session recording files section.

The archive command of the ICLDB utility has several parameters that are described as follows:

• /RETENTION:<days> ‑ The retention period in days for session recordings. Recordings older
than the number of days specified are marked as archived in the Session Recording Database.
The retention period must be an integer number greater than or equal to 2 days.

• /LISTFILES –Lists the full pathand file nameof session recording files as theyarebeingarchived.
This parameter is optional.

• /MOVETO:<directory> ‑ Thedirectory towhich youphysicallymove archived session recording
files. The specified directory must exist. This parameter is optional. If no directory is specified,
files remain in their original storage location.

• /NOTE:<note> ‑ A text note that is added to the database record for each session recording
archived. Ensure that the note is enclosed with double quotes. This parameter is optional.

© 1999–2024 Cloud Software Group, Inc. All rights reserved. 171

https://docs.citrix.com/en-us/xenapp-and-xendesktop/7-15-ltsr/monitor/session-recording/reference.html#restore-session-recording-files


Session Recording 1912 LTSR

• /L –Logs the results and errors to theWindows event log of the number of session recording files
archived. This parameter is optional.

• /F –Forces the archive command to run without prompts. This parameteris optional.

To archive session recordings in the Session Recording Database and physically move session
recording files

1. Log on to the server where the Session Recording Server is installed as a local administrator.

2. Start a command prompt.

3. Change from the current working directory to the Bin directory of the Session Recording Server
installation path (<Session Recording Server Installation Path>/Server/
Bin).

4. Run theICLDB ARCHIVE /RETENTION:<days> /LISTFILES /MOVETO:<directory
> /NOTE:<note> /L command where days is the retention period for session recording
files, directory is the directorywhere archived session recording files aremoved to, and note is
the text note that is added to the database record for each session recording file being archived.
Enter Y to confirm the archive.

To only archive session recordings in the Session Recording Database

1. Log on to the server where the Session Recording Server is installed as a local administrator.

2. Start a command prompt.

3. Change from the current working directory to the Bin directory of the Session Recording Server
installation path (<Session Recording Server Installation Path>/Server/Bin).

4. Run the ICLDB ARCHIVE /RETENTION:<days> /LISTFILES /NOTE:<note> /L
command where days is the retention period for session recordings and note is the text note
that is added to the database record for each session recording being archived. Enter Y to
confirm the archive.

Restore session recording files

Restoration of session recording files is required when you want to view a session recording that was
archived in the Session Recording Database and the file has been moved from the recording storage
location. Archived session recordings thatwere notmoved from the recording storage locationduring
archiving are still accessible in the Session Recording Player.
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Two methods are available for restoring session recording files that have been moved. Copy the re‑
quired session recording file to the restore directory for archived files, or import the required session
recording file back to the Session Recording Database by using the ICLDB utility. Citrix recommends
the first method for restoring archived session recording files. Remove archived files copied to the
restore directory for archived files when you no longer need them.

TheSessionRecordingBroker utilizes theRestoredirectory for archived fileswhena session record‑
ing file is not found in its original storage location. This caseoccurswhen theSessionRecordingPlayer
requests a session recording file for playback. The Session Recording Broker first attempts to find the
session recording file in the original storage location. If the file is not found in the original storage loca‑
tion, the Session Recording Broker then checks the Restore directory for archived files. If the file is
present in the restore directory, the Session Recording Broker sends the file to the Session Recording
Player for playback. Otherwise, if the file is not found, the Session Recording Broker sends a file not
found error to the Session Recording Player.

Importing archived session recording files by using the ICLDB utility updates the Session Recording
Database with session recording information from the session recording file, including a new storage
path for the session recording file. Using the ICLDB utility to import an archived session recording file
does not move the file back to the original storage location when the session was recorded.

Note: An imported session recording file has the archive time and archive note cleared in the Session
Recording Database. Therefore, the next time the ICLDB archive command is run, the imported
session recording file might become archived again.

The ICLDB import command is useful to import a large number of archived session recording files,
repair, or update incorrect and missing session recording data in the Session Recording Database, or
move session recording files from one storage location to another storage location on the Session
Recording Server. The ICLDB import command can also be used to repopulate the Session Recording
Database with session recordings after running the ICLDB removeall command.

The import command of the ICLDB utility has several parameters that are described as follows:

• /LISTFILES –Lists the full path and file name of session recording files while they are being im‑
ported. This parameter is optional.

• /RECURSIVE –Searches all subdirectories for session recording files. This parameter is optional.

• /L –Logs the results and errors to the Windows event log the number of session recording files
imported. This parameter is optional.

• /F –Forces the import command to run without prompts. This parameter is optional.

To restore session recording files by using the restore directory for archived files

1. Log on to the server where the Session Recording Server is installed as a local administrator.
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2. In Session Recording Player Properties, determine the File ID and Archive Time of the archived
session recording file.

3. Locate the session recording file in your backups using the File ID specified in SessionRecording
Player Properties. Each session recording has a file name of i_<FileID>.icl, where FileID
is the ID of the session recording file.

4. Copy the session recording file from your backup to the restore directory for archived files. To
determine the restore directory for archived files:

a) From the Startmenu, choose Start > All Programs > Citrix > Session Recording Server
Properties.

b) In Session Recording Server Properties, select the Storage tab. The current restore direc‑
tory appears in the Restore directory for archived files field.

To restore session recording files by using the ICLDB import command

1. Log on to the server where the Session Recording Server is installed as a local administrator.

2. Start a command prompt.

3. Change from the current working directory to the Bin directory of the Session Recording Server
installation path (<Session Recording Server Installation Path>/Server/
Bin).

4. Either:

• Run the ICLDB IMPORT /LISTFILES /RECURSIVE /L <directory> com‑
mand where directory is the name of one or more directories, separated by a space
containing session recording files. Enter Y to confirm the import.

• Run theICLDB IMPORT /LISTFILES /L <file> commandwhere file is the name
of one or more session recording files, separated by a space. Wildcards might be used to
specify session recording files. Enter Y to confirm the import.
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